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chapter 1

Introduction
Welcome to Pro Tools|HD. Pro Tools|HD-series 
audio cards and interfaces, together with 
Pro Tools software version 5.3 or higher, pro-
vide high-definition audio, high sample rates, 
and many powerful mixing and I/O capabilities 
to Pro Tools.   This guide tells you how to install 
Pro Tools|HD hardware and Pro Tools version 
5.3 software on Macintosh and Windows plat-
forms. System and installation tests are pro-
vided, as well as a chapter covering the basics of 
working with Pro Tool (designed for anyone 
who is new to Pro Tools).

Pro Tools TDM Systems
Pro Tools 5.3 supports the following TDM (Time 
Division Multiplex) systems:

Pro Tools|HD 1, HD 2, and HD 3

A system includes:

• HD Core card.

• HD Process card; HD 2 and HD 3 come with 
one and two Process cards, respectively (HD 1 
does not include a Process card).

• Pro Tools software.

• Digidesign audio interface (sold separately).

• DigiLink cable (to connect I/O to HD card).
• TDM FlexCable (to connect two HD cards); 
one TDM Flex Cable per each Process card 
(HD 1 does not include a TDM FlexCable).

Each system provides:

• For HD 1: up to 96 tracks at 44.1 or 48 kHz, 48 
tracks at 88.2 or 96 kHz, or 12 tracks at 176.4 
or 192 kHz, of recording and playback of 24-
bit and 16-bit audio files.

• For HD 2 and HD 3: up to 128 tracks at 44.1 or 
48 kHz, 64 tracks at 88.2 or 96 kHz, or 24 
tracks at 176.4 or 192 kHz, of recording and 
playback of 24-bit and 16-bit audio files.

All systems provide:

• TDM digital mixing and DSP plug-in environ-
ment.

• Non-linear, random-access editing and mix 
automation.

• MIDI recording, playback and editing.

Pro Tools system performance depends on 
factors such as computer processor speed, 
amount of system memory, and hard drive 
performance. Refer to “System Require-
ments” on page 3.
Chapter 1: Introduction 1
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Audio Interfaces

To record and play audio you must have one of 
the following Digidesign audio interfaces:

192 I/O Audio Interface

◆ Supports sample rates up to 192 kHz. At least 
one 192 I/O must be connected to your 
Pro Tools|HD system for 192 kHz recording, 
mixing, playback, and so on.

◆ Supports a multitude of analog and digital 
connections, including AES/EBU, S/PDIF, TDIF, 
and ADAT optical:

• Digital I/O Card: eight channels, DB-25 
(AES/EBU and TDIF), or one pair of Light-
pipe (ADAT) connectors. Expandable up to 
16 channels digital I/O with the addition of 
the 192 Digital expansion card.

• Analog: eight channels, DB-25 (balanced) 
connectors, inputs selectable between 
+4 dBu or –10 dBV, outputs +4 dBu only. 
Expandable up to 16 analog inputs or 16 
outputs using an optional 192 AD or 192 
DA expansion card, respectively.

• Digital: two channels, XLR (AES/EBU) con-
nectors; two channels RCA (S/PDIF) con-
nectors.

• Optical: eight channels, a pair of Lightpipe 
(ADAT) connectors (selectable to two chan-
nels, S/PDIF).

• Word Clock in and out receive or send 1x 
Word clock (configurable to 256x for Leg-
acy support, see “Optional Legacy I/O Au-
dio Interfaces” on page 2).
Getting Started with HD
96 I/O Audio Interface

◆ Supports sample rates up to 96 kHz.

◆ Supports analog and digital connections, in-
cluding AES/EBU, S/PDIF, and ADAT optical:

• Analog: eight channels, 1/4” TRS (balanced 
or unbalanced) connectors, +4 dBu or 
–10 dBV.

• Digital: two channels, XLR (AES/EBU) con-
nectors; two channels, RCA (S/PDIF) con-
nectors.

• Optical: eight channels, one pair of Light-
pipe (ADAT) connectors (selectable to two 
channels, S/PDIF).

• Word Clock in and out receive or send 1x 
Word clock (configurable to 256x for Leg-
acy support, see “Optional Legacy I/O Au-
dio Interfaces” on page 2).

Optional Legacy I/O Audio Interfaces

For additional input and output channels, older 
Digidesign audio interfaces (called Legacy I/Os) 
can be connected to the 192 I/O or 96 I/O. Leg-
acy interfaces can only be used with 44.1 or 48 
kHz sessions. These include:

888|24 I/O

◆ Analog: eight channels, XLR (balanced or un-
balanced) connectors, selectable between 
+4 dBu or –10 dBV.

◆ Digital: eight channels, XLR (AES/EBU) con-
nectors; two channels, RCA (S/PDIF) connec-
tors.

882|20 I/O

◆ Analog: eight channels, 1/4” TRS (balanced or 
unbalanced) connectors, selectable between 
+4 dBu and –10 dBV.

◆ Digital: two channels, RCA (S/PDIF) connec-
tors.



                              
1622 I/O

◆ Analog: sixteen input channels and two out-
put channels, 1/4” TRS (balanced or unbal-
anced) connectors. Inputs are selectable from 
+4 dBu to –10 dBV line levels and higher in 2 dB 
gain steps; outputs are selectable between 
+4 dBu or –10 dBV.

◆ Digital: two channels, RCA (S/PDIF) connec-
tors.

Digidesign 24-bit ADAT Bridge I/O and Original 
ADAT Bridge I/O

◆ Optical: sixteen channels, a pair of Lightpipe 
(ADAT) connectors.

◆ Analog output: two channels, 1/4” TRS (bal-
anced) connectors, selectable between +4 dBu 
and –10 dBV.

◆ Digital: two channels, XLR (AES/EBU); two 
channels RCA (S/PDIF) connectors.

System Requirements
The CPU, hard disk, monitoring, and MIDI re-
quirements for Pro Tools differ depending on 
your system configuration and computer plat-
form (Macintosh or Windows). The require-
ments for each configuration are listed below. 

Compatibility Information

Digidesign can only assure compatibility and 
provide support for hardware and software it 
has tested and approved. For a list of Digidesign-
qualified computers, operating systems, and 
third-party devices, refer to the latest compati-
bility information on the Digidesign Web site:

www.digidesign.com/compato/

The original 888 I/O and 882 I/O interfaces 
are not supported with Pro Tools|HD.
Computer Requirements

Macintosh

◆ A Digidesign-qualified Power Macintosh com-
puter with:

• 1 unused PCI slot for Pro Tools|HD 1 sys-
tems (64-bit slot recommended).

• 2 unused adjacent PCI slots for 
Pro Tools|HD 2 systems (64-bit slots recom-
mended).

• 3 unused adjacent PCI slots for 
Pro Tools|HD 3 systems (64-bit slots recom-
mended).

• For systems with an expansion chassis, the 
expansion chassis host card takes the place 
of the HD Core card, and all of the 
Pro Tools|HD cards are placed in the chas-
sis.

• A CD-ROM or equivalent optical drive.

◆ Apple System software version 9.1, 9.2, 9.2.1, 
or 9.2.2.

• At least 256 MB RAM (Pro Tools application 
“Preferred” memory allocation set to 
134 MB).

• Additional RAM is required for:

• High edit density sessions, extensive use of 
plug-ins and addition of options such as 
MachineControl, DigiTranslator, and 
AVoption|XL (384 MB recommended).

The maximum number of HD-series cards 
supported in an expansion chassis is seven. 
However, there may be further restrictions 
depending on your operating system and the 
specific model of your expansion chassis. 
For more information, visit the Digidesign 
Web site at:

www.digidesign.com/compato/
Chapter 1: Introduction 3
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• Sessions larger than the default track size—
384 MB minimum, 512 MB recommended 
(Pro Tools application “Preferred” memory 
allocation set to 225 MB). Default session 
sizes are 64 tracks at 44.1/48 kHz, 32 tracks 
at 88.2/96 kHz, and 12 tracks at 
176/192 kHz.

• Virtual memory is not supported.

◆ System Utility software (included with 
Pro Tools):

• OMS (Open Music System) software ver-
sion 2.3.8, installed on the hard drive in 
the Opcode folder.

• Apple QuickTime System Extension ver-
sion 5.0.2, replaces any older version in the 
Extensions folder.

• ATTO ExpressPro-Tools version 2.3.2 or 
later, installed on the hard drive in its own 
folder.

◆ A 17-inch or larger color monitor; black and 
white monitors are not supported.

Windows

◆ A Digidesign-qualified, uniprocessor 
Pentium III or Pentium 4-based computer:

• 1 unused PCI slot for Pro Tools|HD systems 
(64-bit slot recommended).

• 2 unused adjacent PCI slots for 
Pro Tools|HD 2 systems (64-bit slots recom-
mended).

• 3 unused adjacent PCI slots for 
Pro Tools|HD 3 systems (64-bit slots recom-
mended).

• For systems with an expansion chassis, the 
expansion chassis host card takes the place 
of the HD Core card, and all of the 
Pro Tools|HD cards are placed in the expan-
sion chassis.

• VIA Apollo Pro133 or Intel 440BX chipsets 
for Pentium III.
Getting Started with HD
• Intel 860 or Intel 850 chipsets for 
Pentium 4.

• Phoenix or Award BIOS.

• A CD ROM or equivalent drive.

• An AGP display card.

• Windows XP Home Edition, or Windows 
2000 Professional Edition with Service Pack 
2 or higher.

• At least 256 MB RAM.

• Additional RAM is required for:

• High edit density sessions, extensive use of 
plug-ins and addition of options such as 
MachineControl, DigiTranslator, and 
AVoption|XL (384 MB recommended).

• Sessions larger than the default track size—
384 MB minimum, 512 MB recommended. 
Default session sizes are 64 tracks at 
44.1/48 kHz, 32 tracks at 88.2/96 kHz, and 
12 tracks at 176/192 kHz.

• Virtual memory is not supported.

◆ A 17-inch or larger color monitor. Black and 
white monitors are not supported.

Hard Drive Requirements

Macintosh

For audio recording and storage, all Pro Tools 
TDM systems require one or more Digidesign-
qualified drives.

For example, for 96-track, 24-bit, at 44.1 or 
48 kHz performance, a TDM system must in-
clude at least three Digidesign-qualified SCSI 
hard drives attached to a qualified SCSI HBA 
(host bus adapter) card.



       
For 96-track sessions that have substantial edit 
densities (such as one edit every third of a sec-
ond across 96 voices) or large amounts of cross-
fades, up to four SCSI drives may be required, al-
located with 24 tracks per drive and two drives 
per SCSI channel.

The following track count and sample rate ex-
amples require four hard drives:

• 128 tracks at 44.1 or 48 kHz

• 64 tracks at 88.2 or 96 kHz

• 24 tracks at 176.4 or 192 kHz

Dedicated internal IDE/ATA drives can provide 
32-track, 24-bit, at 44.1 or 48 kHz performance 
to all TDM systems.

Refer to the Digidesign Web site for compatible 
hard drives and SCSI HBA cards:

www.digidesign.com/compato/

Windows

For audio recording and storage, all Pro Tools 
TDM systems require one or more Digidesign-
qualified SCSI drives attached to a qualified PCI 
SCSI HBA card or qualified built-in SCSI HBA 
connector on the motherboard.

For best 96-track, 24-bit performance, use four 
hard drives, with audio files distributed among 
them.

IDE drives are also supported for use as audio 
and session drives on Windows-based Pro Tools 
systems (with limited track counts). 24-bit ses-
sions are compatible with IDE drives.

Drives formatted as FAT32 are recom-
mended for quicker disk priming time when 
starting a Pro Tools record operation.
For audio recording and storage, all Pro Tools 
TDM systems require one or more Digidesign-
qualified drives.

For example, for 96 track, 24-bit, at 44.1 or 48 
kHz performance, a TDM system must include 
at least three Digidesign-qualified SCSI hard 
drives attached to a qualified SCSI HBA (host 
bus adapter) card.

For 96-track sessions that have substantial edit 
densities (such as one edit every third of a sec-
ond across 96 voices) or large amounts of cross-
fades, up to four SCSI drives may be required, al-
located with 24 tracks per drive and two drives 
per SCSI channel.

The following track count and sample rate ex-
amples require four hard drives:

• 128 tracks at 44.1 or 48 kHz

• 64 tracks at 88.2 or 96 kHz

• 24 tracks at 176.4 or 192 kHz

Refer to the Digidesign Web site for compatible 
hard drives and SCSI HBA cards:

www.digidesign.com/

For maximum performance, Digidesign rec-
ommends the use of SCSI hard drives. IDE 
hard drives provide limited track count per-
formance and are not supported when an 
Expansion Chassis is used for expanded 
Pro Tools systems. For more information re-
garding Expansion Chassis operating proce-
dures, see the Pro Tools Expanded Systems 
Guide.
Chapter 1: Introduction 5
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MIDI Requirements

Both USB and serial MIDI interfaces work effec-
tively with Pro Tools.

PCI-based serial expanders do not work with se-
rial MIDI interfaces on Macintosh systems. Se-
rial MIDI interfaces require a qualified modem-
to-serial port adapter. Refer to the Digidesign 
compatibility page for supported adapters:

www.digidesign.com/compato/

Digidesign Registration
Make sure to complete and return the registra-
tion card included with your Pro Tools TDM sys-
tem. Registered users are entitled to one year of 
free technical support, and will receive periodic 
software updates and upgrade notices.
Getting Started with HD
About the Pro Tools Guides
PDF versions of the Pro Tools guides are in-
stalled automatically with Pro Tools, and can be 
easily accessed from the Help menu in 
Pro Tools. To read the guide online, or print it, 
you must install Acrobat Reader (included on the 
Pro Tools Installer CD).

Conventions Used in This Guide

Digidesign guides use the following conven-
tions to indicate menu choices and key com-
mands:

The following symbols are used to highlight im-
portant information:

Convention Action

File > Save 
Session

Choose Save Session from the 
File menu

Control+N While pressing the Control key, 
press the N key

Option-click While pressing the Option key, 
click the mouse button

Right-click 
(Windows)

Click with the right mouse button

User Tips are helpful hints for getting the 
most from your system.

Important Notices include information that 
could affect your data or the performance of 
your system.

Cross References point to related sections in 
other Digidesign guides.



            
Choose and Select

The words “choose” and “select” are often inter-
changeable in conversational english. In this 
guide, however, there is a distinction between 
the two terms.

Select When the guide instructs you to select 
something, it stays selected. This is the case with 
dialog box options and menu items that enable 
or disable an option.

Choose When the guide instructs you to choose 
something, a one-time action is performed. This 
is the case with most menu commands; they 
perform their chosen action only once.
Chapter 1: Introduction 7
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chapter 2

Macintosh Configuration
To configure your Pro Tools|HD system for Mac-
intosh, you will need to install Pro Tools hard-
ware and software, verify your TDM system, 
then launch Pro Tools.

Installing Pro Tools Hardware

Pro Tools TDM Cards

The number of Pro Tools TDM cards will differ 
depending on your system configuration. Card 
components for each configuration are listed 
below.

Pro Tools|HD Hardware

Pro Tools|HD hardware comes in three configu-
rations:

Pro Tools|HD 1 Includes a single HD Core card.

Pro Tools|HD 2 Includes an HD Core card, an HD 
Process card, and a TDM FlexCable for connect-
ing the HD Core to the HD Process card.

If you are using an Expansion Chassis to 
add additional cards to your system, refer to 
the Expanded Systems Guide included with 
your Pro Tools system.
Pro Tools|HD 3 Includes an HD Core card, two 
HD Process cards, and two TDM FlexCables (one 
for connecting the HD Core to the first HD Pro-
cess card, and the other for connecting the first 
HD Process card to the other HD Process card).

The HD Core Card

The HD Core card provides up to 96 tracks of di-
rect-to-disk recording and playback, and 32 
channels of I/O to your Pro Tools HD-series sys-
tem, as well as DSP power for processing and 
mixing. The HD Core card supports up to 24-bit 
and up to 192 kHz sessions.

This card includes a single DigiLink port for con-
necting up to 32 channels of I/O. 

HD Core card

DigiLink
port

DigiSerial 
port
Chapter 2: Macintosh Configuration 9
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The DigiSerial port is for connecting a Digide-
sign SYNC I/O. This connector is an 8-pin mini-
DIN.

The HD Process Card

The HD Process card provides DSP power for 
mixing, processing, and DSP software such as 
the DigiRack plug-ins included with Pro Tools. 
It also provides a DigiLink port for connecting 
up to 32 channels of I/O. 

The DigiSerial port on an HD Process card does 
not offer any functionality.

The DigiSerial port on HD Core cards does 
not support MachineControl connections. 
Use the Digidesign SYNC I/O for Pro Tools 
MachineControl 9-pin. A serial port (not a 
DigiSerial port) is required for MC Remote 
mode (only). For a list of qualified serial 
port adapters (such as USB), see:

www.digidesign.com/compato

HD Process card

DigiLink
port

DigiSerial 
port
Getting Started with HD 
The TDM FlexCable

The TDM FlexCable is used to connect a pair of 
cards in your Pro Tools system so they can share 
data along the TDM bus. Additional FlexCables 
are required to connect additional cards. One 
FlexCable comes with each HD Process card.

Installing the Pro Tool|HD Cards

This section shows how to install Pro Tools HD 
cards into a Macintosh CPU. If you're installing 
cards into an expansion chassis, see the Ex-
panded Systems Guide.

To install the Pro Tools cards:

1  Turn off your computer and any peripherals. 
Make sure the equipment is properly grounded. 

2  Disconnect all cables attached to the CPU 
(such as hard drives, monitor(s), USB and 
firewire connections) except for power.

3  Open the computer case.

The TDM FlexCable is actually a flexible 
printed circuit board with delicate traces. 
Do not overbend the cable, twist it, or oth-
erwise pinch it. Doing so may cause unpre-
dictable behavior in Pro Tools as well as 
harm to your system.

TDM FlexCable, shown properly bent

Before handling any card, discharge any 
static electricity that may be on your clothes 
or body by touching a grounded metal sur-
face, such as the power supply case inside 
your computer.



                  
4  Remove the metal access port cover behind 
the PCI slot you want to use by removing the 
screw and sliding the cover out from the access 
port. Keep the screws in a safe place.

5  Install the HD Core card into the lowest num-
bered slot inside the CPU as shown in the fol-
lowing figures. The HD Core card will always be 
installed in the lowest numbered PCI slot. 

Make sure the first card is an HD Core card. HD 
Process cards cannot occupy the lowest slot.

The following figures show the lowest slot for 
Power Macintosh computers supported by 
Pro Tools. 

6  Install HD Process cards in the following slots.

G4 Dual Processor

G4 Processor

PCI slot 4
PCI slot 3
PCI slot 2

AGP slot 1 (video card)

PCI slot 4
PCI slot 3
PCI slot 2

PCI slot 1 (video card)
7  If installing a SCSI HBA card, install it in the 
highest numbered remaining slot.

8  If installing other cards, verify that your cards 
are installed in the following order, starting with 
the lowest numeric slot.

For each Pro Tools TDM system, your cards 
should be installed in the following order, start-
ing with the lowest numeric slot.

• HD Core cards

• HD Process cards

• SCSI host bus adapter (HBA)

• Video capture cards

• Display card for your computer monitor

9  If installing an HD Core system (and not a 
Pro Tools|HD 2 or HD 3 system), complete the 
following:

• Secure the card in place with the slot access 
port screw you removed earlier.

• Close the computer case.

• Skip the following steps and continue with 
“Connecting Audio Interfaces” on page 13.

10  If installing a Pro Tools|HD 2, HD 3, or an Ex-
panded HD 1 system, connect the HD cards with 
TDM FlexCables (see “Connecting Multiple 
Cards with the TDM FlexCable” on page 12).

The guidelines below may include optional 
cards not present in your system.

Do not use SampleCell hardware cards in a 
Pro Tools|HD system. Doing so can result 
in system crashes. Instead, please use Soft 
SampleCell which has been specifically en-
gineered to support 24-bit depths and 
higher sampling rates.
Chapter 2: Macintosh Configuration 11
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Connecting Multiple Cards with the TDM 
FlexCable

Each HD card has two ports along the top of the 
card, labelled Port A and Port B. 

When installing multiple HD cards, data com-
munication across HD cards is achieved by us-
ing a TDM FlexCable to connect Port B of the 
lead card to Port A of the next card. The FlexCa-
ble has two connectors, also labeled Port A and 
Port B, to ensure proper connection.

To connect HD cards with the TDM FlexCable:

1  Make sure you have secured cards with the 
slot access port screws you removed earlier.

2  The FlexCable needs to be shaped before in-
stalling it on your HD cards. To do this, grasp it 
with both hands, then move the Port A portion 
of the cable straight towards you and inwards, as 
shown below. Do not bend the cable more than 
you need to, as you may damage the traces in 
the cable.

3  Slide the FlexCable into the notch of the sec-
ond card, so that the Port B connector of the 
FlexCable can be aligned with Port B of the lead 
card; and the Port A connector of the FlexCable 
can be aligned with Port A of the second card (as 
shown in the following diagram).

Preparing TDM FlexCable for installation

PORT A PORT B PORT A

PORT B
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4  Connect the Port A connector of the FlexCa-
ble to Port A on the second card. Push down 
gently but firmly until the cable is fully con-
nected to the card. Next, attach the other end of 
the FlexCable (labeled Port B) to Port B on the 
lead card.

5  Verify the connection, as shown below.

6  For systems with more than two cards, each 
additional card must be connected to its preced-
ing card. Use FlexCables to connect cards to-
gether, as described above, until all cards are 
connected. Each subsequent HD Process card 
will include a FlexCable.

Inserting TDM FlexCable

Top view of two HD cards connected with TDM FlexCable

Side view of two HD cards connected with TDM 
FlexCable

PORT B

PORT B

PORT A

PORT A

PORT B

PORT A

PORT A

PORT B

PORT B

PORT B

PORT A

PORT A

PORT B

PORT B

PORT A

PORT A

PORT B

PORT APORT A

PORT B



Figure 1.  Two 96 I/Os, 32-channel

1.5 ft (0.5 m)
DigiLink cable 12 ft (4 m) DigiLink cable

HD card
Connecting Audio Interfaces

Each interface supplies up to 16 channels of in-
put and output to your system.

Pro Tools|HD supports up to a maximum of 
eight 192 I/Os or 96 I/Os. 

Each HD card supports up to 32 channels; to get 
a full 32 channels of I/O from one card, you can 
connect, or daisy chain, a second 16-channel 
HD I/O to the first HD I/O that is connected di-
rectly to the HD card (Figure 1).

HD audio interfaces need room at their 
sides to maintain proper air flow for cool-
ing. It is important to leave room for air in-
take and ventilation on the sides of the unit. 
Do not block the sides of the unit or discon-
nect the internal fan. If the units are racked 
up in a case, remove all lids and/or doors 
before operating the system. Failure to do so 
can result in the units overheating very 
quickly, which can permanently damage 
sensitive components.
In addition, previous generations of audio inter-
faces can be connected to the 192 I/O or 96 I/O. 
These include: 888|24 I/O, 882|20 I/O, 
1622 I/O, 24-bit ADAT Bridge I/O, and the orig-
inal ADAT Bridge I/O. The original 888 I/O and 
882 I/O interfaces are not supported with 
Pro Tools|HD.

To connect the HD audio interfaces:

1  If using a single 192 I/O or 96 I/O, connect it 
to the HD Core card with the provided DigiLink 
cable that came in the HD Core packaging. You 
must attach at least one 192 I/O or 96 I/O to 
your system in order for Pro Tools to boot.

2  Connect additional HD audio interfaces to 
subsequent Digidesign audio cards or daisy 
chain your I/Os (by connecting a secondary I/O 
to the primary I/O).

If you have at least one 192 I/O in your sys-
tem configuration, it must be connected to 
the HD Core card as the “primary” inter-
face.
Chapter 2: Macintosh Configuration 13
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Figure 2.  Three 96 I/Os, 48-channel

loop sync cables

12 ft (4 m) DigiLink cable

HD card

TDM FlexCable

1.5 ft (0.5 m)
DigiLink cable 12 ft (4 m) DigiLink cable

HD card
If you are connecting both 192 and 96 I/O audio 
interfaces to your system, connect the 192 I/O 
to your HD Core card, followed by any addi-
tional 192 I/O interfaces connected to the next 
highest-priority cards. Then connect the 96 I/O 
interfaces to subsequent cards.

You can also connect a single HD I/O to each HD 
card in your system using the provided DigiLink 
cables. There is no advantage to this configura-
tion over daisy chaining I/Os.

3  If using two or more HD audio interfaces, con-
nect the Loop Sync Out of each interface to the 
Loop Sync In of the next interface with the BNC 
cables included in your HD I/O packaging. 
Then, connect the Loop Sync Out of the last in-
terface to the Loop Sync In of the primary inter-
face.
4  If connecting a Digidesign Legacy audio inter-
face (such as an 888|24 I/O, 882|20 I/O, or 
1622 I/O, or a Digidesign ADAT Bridge I/O), 
continue with “Connecting an Additional 16 
Channels of Audio to Legacy I/Os” on page 15.



Connecting an Additional 16 Channels 
of Audio to Legacy I/Os

Each 192 I/O and 96 I/O can support 16 chan-
nels of audio to and from Digidesign Legacy pe-
ripherals. These include: 888|24 I/O, 882|20 I/O, 
1622 I/O, 24-bit ADAT Bridge I/O, and the orig-
inal ADAT Bridge I/O. The original 888 I/O and 
882 I/O interfaces are not supported with 
Pro Tools|HD.

To connect Digidesign Legacy I/Os:

1  Connect the “MIX card” end of the peripheral 
cable that came with your Legacy I/O (60-pin 
side) to the Legacy Port on the primary HD au-
dio interface. Connect the other end to the 
Computer Port on the Legacy I/O. Connect ad-
ditional Legacy I/Os, if any, in the same manner, 
to HD audio interfaces connected directly to HD 
Process cards.

If using a Y cable or 16-channel peripheral cable 
adapter, connect this to the Legacy port first, 
then connect the audio interface peripheral ca-
bles to Port A and Port B of the Y cable.

Optional 16-channel peripheral cable adapter

“A” to first
Legacy I/O

“B” to second
Legacy I/O

to Legacy Port on
HD audio interface
2  In order to properly clock the Legacy device, 
you will need to connect the Ext. Clock output 
port on the HD I/O to the Slave Clock IN on the 
Legacy peripheral. The Legacy peripheral will 
switch to Slave mode once the proper clock is 
outputting from the HD I/O. Always use the Ext. 
Clock Out port of the same I/O to which the 
Legacy peripheral is attached.

If using multiple MIX-series audio interfaces, 
connect the Slave Clock Out of the first interface 
to the Slave Clock In of the second interface 
with the provided BNC cable. If using three 
888|24 or other MIX-series I/Os, the third 
888|24 would get its 256x clock from the second 
HD I/O to which the Legacy peripheral is at-
tached.

Before you turn on and configure your Leg-
acy I/O, turn down the volume of output de-
vices. Very loud digital noise may be emit-
ted before the Legacy I/O is initialized.
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Installing Pro Tools Software
The complete Pro Tools software installation 
process includes:

• Preparing your Apple System software for 
Pro Tools

• Installing Pro Tools software

• Installing OMS

After software installation is completed, the first 
time you launch Pro Tools you will be prompted 
to enter your Pro Tools authorization code and 
configure hardware. Instructions for this begin 
in “Checking Your TDM System and Launching 
Pro Tools” on page 18.

Apple System Software Settings

To ensure optimum performance with 
Pro Tools, configure the Apple System software 
with the following settings for OS9.1, 9.2, 9.2.1, 
or 9.2.2.

To configure the Apple System software for 
optimum Pro Tools use:

1  In the Memory Control Panel do the follow-
ing:

• Set the Disk Cache to a Custom Setting of 
512 K.

• Set Virtual Memory to Off.

• Set the Ram Disk to Off.

2  In the Energy Saver Control Panel, set the “in-
active” time to Never.

3  In the Appearance Control Panel do the fol-
lowing:

If you haven’t already installed Pro Tools 
hardware, do so now. See “Installing 
Pro Tools Hardware” on page 9 for instruc-
tions.
Getting Started with HD 
• Click the Fonts tab and set the Large System 
Font to Chicago. In addition, deselect 
“Smooth all fonts on screen.”

• Click the Sound tab and select None from the 
Sound Track pop-up menu.

4  In the Extensions Manager Control Panel do 
the following:

• Choose Mac OS 9.1 Base (or Mac OS 9.2 Base, 
Mac OS 9.2.1, or Mac OS 9.2.2) from the Se-
lected Set pop-up menu. This is done to avoid 
any potential extensions conflicts.

• Click Restart to restart your computer.

Installing Pro Tools Software

To install Pro Tools software:

1  Locate the Pro Tools 5.3 Installer CD for Mac-
intosh and place it in your CD-ROM, or equiva-
lent. 

2  Locate and double-click the file named “In-
stall Pro Tools.”

3  Select the hard drive on which to install 
Pro Tools from the Install Location pop-up 
menu. For maximum reliability, install 
Pro Tools on your startup drive.

4  Select the Pro Tools 5.3 Installer.

5  Several optional items are listed directly below 
the main installation choices. To install any of 
these items, select them from the list.

Digidesign Control Panel Add this item if you 
want to use your Digidesign hardware with 
Sound Manager-compatible applications.

Machine Control Guide Install this document if 
you also use Digidesign’s MachineControl op-
tion for Pro Tools. 



SYNC I/O Setup Add this to your installation if 
you own a Digidesign SYNC I/O. SYNC I/O 
Setup lets you update SYNC I/O firmware and 
configure the SYNC I/O remotely. TDM systems 
need only install SYNC I/O Setup if access to the 
complete set of SYNC I/O features is required. 
SYNC I/O Setup requires a serial port (either 
Stealth or Keyspan USB adapter). Refer to the 
SYNC I/O Guide for details. 

OMF Utilities Add this to your installation if you 
are an OMF (Open Media Framework) user. 

6  After selecting from the above options, click 
Install.

Preference settings can be customized at any 
time in Pro Tools. See the Pro Tools Reference 
Guide for more information about Preferences.

7  Select a “work environment.” This is an initial 
set of Product Name Preferences. These Prefer-
ence “sets” have been pre-configured to include 
some of the more popular settings for post pro-
duction, audio, and audio with MIDI. After se-
lecting a setting, Click Continue.

Selecting a Pro Tools Preference

Preference settings can be customized at any 
time in Pro Tools. See the Pro Tools Refer-
ence Guide for more information about Pref-
erences.
8  Select whether to install the Surround Mixer 
plug-in. This plug-in is required for mixing, 
mastering, and monitoring in surround. For Sur-
round systems, select Yes – Monitoring Pro Tools 
Film Format if your monitoring is configured for 
Film Format, or select Yes – Monitoring in Pro-
Control (DTS Format) if using a ProControl ded-
icated controller. Select No – Stereo mixing only, 
if your monitoring is configured for Stereo. After 
making a selection, click Continue.

9  When installation is complete, click Restart 
(to restart your computer).

10  After restarting, install OMS.

Installing OMS

To use MIDI with Pro Tools, you must first in-
stall and configure the Open Music System 
(OMS).

Selecting a Pro Tools Preference

Even if you do not plan on using MIDI, 
OMS must be installed. Pro Tools will not 
launch without OMS.
Chapter 2: Macintosh Configuration 17
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OMS, which is included on the Pro Tools In-
staller CD, has the following capabilities:

• Keeps track of which MIDI devices you are us-
ing, how they are connected, and which 
patches they are using.

• Enables MIDI hardware to communicate with 
your music applications.

• Provides timing services and inter-application 
communication.

OMS stores a description of your MIDI studio in 
Studio Setup documents, which are edited in the 
OMS Setup application. Once OMS is configured, 
your music applications know which MIDI de-
vices you are using by referencing the current 
Studio Setup document.

The following section provides basic instruc-
tions for installing OMS. For OMS configuration 
steps, see “Configuring a New Studio Setup in 
OMS” on page 87. For additional information, 
refer to the online OMS Guide installed with 
Pro Tools.

Installing OMS

The OMS Installer is located on your Pro Tools 
Installer CD.

To install OMS:

1  Insert the Pro Tools Installer CD in your CD-
ROM drive. 

2  Open the OMS Installer folder and double-
click the Installer.

3  At the Install window, select the Easy Install 
option, and set the Install Location to your 
Start-up hard drive. Click Install.

4  Follow the on-screen installation instructions.

5  When the installation is complete, restart 
your Macintosh.
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Checking Your TDM System 
and Launching Pro Tools
We strongly urge you to launch the DigiTest di-
agnostics application before your initial launch 
to Pro Tools. Doing so ensures that you have all 
cards recognized in the system, in the proper or-
der, and with valid TDM FlexCable connections.

DigiTest is located in the Digidesign Utilities 
folder (see “Running DigiTest” on page 19).

When DigiTest has completed, restart your com-
puter, then launch Pro Tools for the first time.

Starting Up Your System

Whenever you start your system, you must turn 
on all of your system components in a specific 
order.

Start your Pro Tools System in this order:

1  Make sure all your equipment (including your 
CPU) is off.

2  For TDM systems with an expansion chassis, 
turn on the expansion chassis.

3  Turn on external hard drives, if any. Wait ap-
proximately ten seconds for them to spin up to 
speed.

4  Lower the volume of all output devices, then 
turn on your Pro Tools audio interfaces.

5  Turn on any MIDI interfaces and devices, or 
synchronization peripherals.

You should also run DigiTest after making 
any changes to your hardware setup (such 
as adding or removing cards, adding or re-
moving audio interfaces, adding or remov-
ing synchronization cables, and so on) to 
verify that your system is correctly config-
ured and functioning properly.



6  Turn on your Pro Tools audio interfaces (such 
as 96 I/O). On power up, the status LEDs will 
flash. Wait at least fifteen seconds for the audio 
interface to initialize, and the status LEDs to 
stop blinking and stay lit.

If you launch Pro Tools without turning on your 
audio interfaces, you will be prompted to turn 
them on. Allow fifteen seconds for audio inter-
faces to power-up and the status LEDs to stop 
blinking and stay lit, before clicking OK.

7  Turn on your computer. 

Running DigiTest

Run the DigiTest diagnostics application to 
identify TDM cards and verify that they are cor-
rectly installed and working.

To run DigiTest:

1  From the Digidesign Utilities folder, double-
click the DigiTest application program. DigiTest 
opens and lists the supported cards it finds in 
your system in their corresponding slot loca-
tion.

DigiTest is included on the Pro Tools In-
staller CD and installed with Pro Tools. 
DigiTest resides in the Digidesign Utilities 
folder located on your hard drive, under 
Digidesign/Pro Tools/Pro Tools Utilities.

Before you run DigiTest, lower the volume 
of your monitoring system and all output 
devices. Additionally, be sure to remove 
your headphones. Very loud digital noise 
may be emitted during the test.
If you have a large amount of cards and/or con-
nected HD I/Os, it may take awhile for the main 
DigiTest screen to appear. This is due to the test 
scanning for all cards and I/Os connected to the 
system.

If a supported card is installed and not listed, 
check card seating and TDM FlexCable connec-
tion. Close DigiTest, power down your system, 
and reinstall the cards (see “Installing the 
Pro Tool|HD Cards” on page 10). After power 
up, begin DigiTest again.

2  From the SlotArrangement menu, select your 
computer. The number of computer card slots 
updates in the main window to reflect your 
computer model.

When you select a computer type, a second win-
dow also opens and displays the lowest slot in 
your computer.

3  If using an expansion chassis, select it from 
the SlotArrangement menu.The number of Ex-
pansion Chassis card slots updates in the main 
window to reflect your chassis type.

DigiTest window
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4  From the DigiTest window, click Run.

DigiTest begins by checking the arrangement of 
your cards. If cards are installed in the correct 
order, DigiTest will automatically continue with 
the next step and check card functionality.

If cards are not installed in the proper order, 
DigiTest will stop, inform you that the system is 
misconfigured, and display error codes in the 
status box of each card identified as being mis-
configured.

The more cards in your system, the longer the 
test will take. Furthermore, the more I/Os con-
nected to the system, the longer it takes.

For descriptions of error codes, refer to 
Appendix B, “DigiTest Error Codes.” For test de-
tails, click the Info button to the right of the re-
ported error, then click Failures in the pop-up 
window and change Failures to Detailed.

Refer to the Digidesign Web site for compatibil-
ity information:

www.digidesign.com/compato/

Make sure you quit and power down your sys-
tem, before reconfiguring your cards.

5  After checking card arrangement, DigiTest 
checks card functionality. The Status box for 
each tested card will indicate Passed or Failed. 

If you haven’t done so already, turn down 
your speakers before running DigiTest. Ad-
ditionally, be sure to remove your head-
phones.

DigiTest only reports valid test results for 
slots which contain Digidesign cards.
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6  If all the Digidesign cards pass, quit DigiTest 
and restart your computer.

– or –

If any cards fail, you can review test details by 
clicking the Info button for the corresponding 
card and slot. Following review, you will need to 
quit DigiTest, power down your system, and re-
install your cards. Verify proper card seating and 
TDM FlexCable cable connection. (See “Install-
ing Pro Tools Hardware” on page 9.) 

If a card continues to fail DigiTest, contact 
Digidesign Technical Support.

tel: 650-731-6100

tel: 650-856-4275

Launching Pro Tools the First Time

Validate Pro Tools Software

When launching Pro Tools the first time, you 
are prompted to enter an authorization code to 
validate your software.

To validate Pro Tools software:

1  Double-click the Pro Tools application in the 
Pro Tools folder inside the Digidesign folder.

2  If OMS was not previously configured, you 
will be prompted to configure a New Studio 
Setup. For specific steps, see Appendix C, “Con-
figuring OMS.”

3  Enter the authorization code in the dialog 
when prompted, making sure to observe any 
spaces, then click Validate.

Authorization code validation for Pro Tools



The authorization code is located on the inside 
cover of this guide. Again, be sure to include any 
spaces in the authorization code.

Congratulations! Pro Tools is launched. When 
Pro Tools is launched for the first time only the 
menus will appear. To see Edit and Mix win-
dows, a new session must be created. But before 
you begin working with Pro Tools, you should 
get acquainted with Pro Tools system settings, 
described in the following section.

Configuring Pro Tools

Configuring the Playback Engine

The Playback Engine sets the voice count (and 
voiceable tracks) for your system, and its ses-
sions. Additionally, it lets you customize various 
System Usage parameters (such as buffers and 
CPU Usage).

To configure the Playback Engine:

1  Choose Setups > Playback Engine.

2  From the H/W Buffer Size pop-up, select the 
audio buffer size, in samples, for host processing 
tasks such as Real-Time AudioSuite (RTAS) plug-
in processing. The default setting is 512 sam-
ples. Select a higher setting if you need more 
buffer time for RTAS, HTDM, and Direct Con-
nect applications.

Playback Engine dialog for Pro Tools TDM system
3  From the CPU Usage Limit pop-up, select the 
maximum percentage of CPU resources to allo-
cate to host processing tasks. The default setting 
is 40%. Select a higher setting if you need more 
buffer time for RTAS, HTDM, and Direct Con-
nect applications.

4  From the Number of Voices pop-up, select the 
amount of voices (and voiceable tracks), for 
your sessions. The default number of voices on a 
Pro Tools|HD 1 system is 48 voices (at the de-
fault 48 kHz sample rate).

Depending on the current sample rate, and the 
number of HD Core and Process cards in your 
system, you will have different choices avail-
able. For example, each HD card allows you to 
use one or two of its DSPs per card for voicing.

Most DSP amounts support three levels of voice 
numbers:

• Select higher voice numbers when your 
cards are in your machine, and you aren’t 
running extra PCI cards which may con-
flict with Digidesign cards. You should also 
select higher voice numbers when using a 
chassis to run higher track counts at higher 
sample rates (such as 64 tracks at 96 kHz) 
and you want more voices (such as 16 
voices per DSP at 96 kHz).

• Select medium voice numbers when run-
ning cards in an expansion chassis, or 
when using other PCI cards along with 
Digidesign cards.

Increasing the CPU Usage Limit may slow 
down screen responses.

Changing the number of voices, along with 
sample rate, affects DSP usage and your 
system performance. Please read the follow-
ing carefully.
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• Select minimum voice numbers if you are 
running high bandwidth PCI cards (such as 
video capture).

For voice limits on different HD systems, refer to 
the Pro Tools Reference Guide.

5  From the Sample Rate pop-up, select the ses-
sion sample rate. This choice will not be avail-
able if a session is open. 

6  Set DAE Playback Buffer Size.

The DAE Playback Buffer Size determines the 
amount of memory allocated within DAE to 
manage disk buffers, which affects system per-
formance.

Though DAE automatically selects the optimal 
playback buffer size for your system, you may 
want to adjust this parameter to modify your 
system’s performance:

◆ Allocating a larger buffer size can sometimes 
allow for a higher density of edits. This can be 
useful if you experience system performance 
problems in sessions with a large number of ed-
its in rapid succession. However, choosing a 
larger buffer size can cause a time lag to occur 
before playback or recording begins. It can also 
cause a time lag to occur when you are editing 
during playback.

◆ Allocating a smaller buffer size can sometimes 
improve playback/recording initiation speed. 
This can be useful if you are experiencing a time 
lag when you initiate playback/recording. How-
ever, choosing a smaller buffer size can make it 
difficult for slower hard drives to play or record 
tracks reliably. 

7  Click OK, when finished.

Session sample rate can always be set in the 
Create a New Session dialog. (See the 
Pro Tools Reference Guide.)
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Configuring Hardware Setup 
(Audio Interfaces)

Pro Tools HD peripherals support 16 channels 
of simultaneous I/O. The peripherals support 
multiple formats (such as analog, AES/EBU, 
TDIF, and so on). 

The Main page of the Hardware Setup dialog is 
where you define what physical ports are routed 
to Pro Tools input and output ports. Think of 
this window as a patchbay that allows you to 
route any of the physical inputs or outputs on 
your HD I/Os to channel assignments in the 
Pro Tools mixer.

The Main page also provides controls for session 
Sample Rate, clock settings, and defining 
whether Expansion Port or Legacy Port periph-
erals are active.

Additional pages are available to configure other 
parameters on each I/O (such as setting operat-
ing levels).

You must select the peripheral, then set the pa-
rameters for that interface—repeating this for 
each interface in your system. 

Hardware Setup dialog for 192 I/O, Main page

Use the Up and Down Arrow keys to scroll 
though each peripheral.



To validate audio interfaces with the Identify 
button:

1  Choose Setups > Hardware in Pro Tools.

2  From the Peripherals list, select the Digidesign 
audio interface connected to the first card in 
your HD system. This will be the interface at the 
top of the list.

3  Make sure Main page tab is chosen.

4  Use the Identify button to verify that your au-
dio interface has been properly identified. Click 
on the Identify button, located in the lower left 
corner of the Hardware Setup dialog, to illumi-
nate all the LEDs on the front panel of the audio 
interface. If the LEDs do not light, make sure the 
interface is selected in the Peripherals list, and 
that it is powered on. If the LEDs continue to 
not light, review hardware installation and run 
DigiTest again.

5  Repeat the above steps for additional audio in-
terfaces.

To configure audio interfaces:

1  Choose Setups > Hardware in Pro Tools.

2  From the Peripherals list, select the Digidesign 
audio interface connected to the first card in 
your HD system. This will be the interface at the 
top of the list.

3  Make sure Main page tab is chosen.

Legacy I/Os must be initialized in the Pe-
ripherals list before they can be validated 
with the Identify button. For initialization 
steps, see “Configuring Legacy I/Os” on 
page 26.
4  To select a different digital I/O on your audio 
interface (enclosure), click on one of the format 
buttons, under Digital Format. Choices include: 
AES/EBU, S/PDIF, and Optical (S/PDIF). Select-
ing Optical (S/PDIF) resets the physical Optical 
I/O port (which is, by default, eight channels of 
ADAT I/O) to two channels of S/PDIF I/O. For 
more information about HD enclosure and card 
ports, refer to the guide for your I/O.

5  From the Clock Source pop-up, select the ap-
propriate clock source for the system. In most 
cases, you will use Internal. The other choices 
are for resolving Pro Tools to external clock 
sources. Depending on your audio interface, 
Clock Source options can include: AES/EBU 
[Encl], S/PDIF, Optical [Encl], AES/EBU 1–8, 
TDIF, ADAT, and Word clock (optional word 
clock rates are available at higher frequencies). 
For more information, see the Pro Tools Reference 
Guide or the guide for your audio interface.

6  From the Ext. Clock Output, select the appro-
priate clock source to feed to devices attached to 
your I/O. 

7  For S/PDIF compatibility with Tascam DA30 
DAT recorders, click on the Tascam button, un-
der S/PDIF Format.

If the Legacy Port is enabled (as opposed to 
the Expansion Port) then the Ext. Clock 
Output automatically switches to 
Slave256x. To reset the Ext. Clock Output, 
the Port Settings button must be set back to 
Expansion and the Legacy I/O must be set to 
No Interface. (To set a Legacy I/O to No In-
terface, select its name in the Peripherals 
list, then click on No Interface in the Inter-
face pop-up menu.)
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8  From the input and output channel pop-ups, 
select the physical ports (such as Analog 1–2, 
Optical 1–2, and so on), that will be routed to 
the Pro Tools input and output ports (such as 
(Ch 1–2, 3–4, and so on).

Refer to your peripheral’s guide for sample rate, 
and other restrictions. For example, the Optical 
1–8 channels (on the enclosure) will not be 
available for session sample rates of 88.2 kHz or 
higher (whereas the ports on the 192 I/O Digital 
I/O card will be available).

To differentiate inputs and outputs of the same 
format, they are labeled differently in the input 
and output channel pop-ups. For example, the 
AES/EBU inputs and outputs that come standard 
in the 192 I/O enclosure are identified as 
AES/EBU [Encl]; the AES/EBU inputs and out-
puts that come on the factory-installed Digital 
port are listed (in pairs) as AES/EBU 1–2, 
AES/EBU 3–4, and so on. For 192 I/Os equipped 
with the optional Digital I/O Card, the addi-
tional AES/EBU I/O ports on the optional card 
are labelled AES/EBU 9–10, AES/EBU 11–12, and 
so on.

9  Configure controls specific to your HD I/O. 
See “Configuring 192 I/O Controls” on page 24 
and “Configuring 96 I/O Controls” on page 25.

10  For additional HD-series I/Os, choose the I/O 
in the Peripherals list, and repeat the above 
steps.
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Configuring 192 I/O Controls

To configure controls specific to a 192 I/O:

1  With the 192 I/O selected in the Peripherals 
list, click on the Analog In tab for the following 
options:

• You can set your operating level by select-
ing Reference Level +4 dBu or –10 dBV, on 
a channel-by-channel basis, based on 
which physical inputs are routed to 
Pro Tools inputs. Refer to the 192 I/O Guide 
for more information.

• Each of the analog channels in the 192 I/O 
has two Input Trims, labelled A and B, for 
precisely calibrating and switching levels. 
Select Input Trim A or B on a channel-by-
channel basis. See the 192 I/O Guide for in-
formation on setting the rear panel trims.

• You can select Soft Clip on a channel-by-
channel basis. The Soft Clip limiter attenu-
ates the incoming analog signal, providing 
extra protection from temporary clipping 
transients that can cause digital distortion 
when they exceed the maximum input of 
the unit. With Soft Clip enabled, 192 I/O 
supports an additional 4 dB of headroom 
by rounding off the top 4 dB to the clip 
point. This is useful for eliminating stray 
transients or emulating analog tape satura-
tion.

Hardware Setup dialog for 192 Analog In page



2  Click on the Analog Out tab for the following 
option:

• Each of the analog channels in the 192 I/O 
has two Output Trims, labelled A and B, re-
spectively. You can select Input Trim A or B 
on a channel-by-channel basis.

3  On the 192 I/O with an optional Digital I/O 
card, click on the Digital tab, to set the Input 
Format and SR Conversion (real-time sample 
rate conversion).

Hardware Setup dialog for 192 I/O, Analog Out page

At session sample rates above 48 kHz, sam-
ple rate conversion for the TDIF and Optical 
(ADAT) inputs on the Digital I/O card is 
automatically enabled on all eight inputs of 
the selected format. 

Hardware Setup dialog for 192 I/O, Digital page
Configuring 96 I/O Controls

To configure controls specific to a 96 I/O:

1  With the 96 I/O selected in the Peripherals 
list, configure your I/O front panel meters for in-
put or output metering from the Meters pop-up.

2  Click on the Analog In tab, for the following 
option:

• You can set your operating level by select-
ing Reference Level +4 dBu or –10 dBV, on 
a channel-by-channel basis, based on 
which physical inputs are routed to 
Pro Tools inputs. Refer to the 96 I/O Guide 
for more information.

Hardware Setup dialog for 96 I/O, Analog Out page
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3  Click on the Analog Out tab, for the following 
option:

• You can set your output level by selecting 
Reference Level +4 dBu or –10 dBV, on a 
channel-by-channel basis, based on which 
physical outputs are routed to Pro Tools in-
puts. Refer to the 96 I/O Guide for more in-
formation.

Configuring Legacy I/Os

Repeat the above steps for any Legacy I/Os (such 
as 888|24 I/O) connected to the first I/O, then 
second, and so on. Before you can configure a 
Legacy I/O, it must first be initialized in Hard-
ware Setup.

To initialize a Legacy I/O:

1  Before you turn on and configure your Legacy 
I/O, turn down the volume of output devices. 
Very loud digital noise may be emitted before 
the Legacy I/O is initialized.

2  Power on your Legacy I/O.

3  From the Peripherals list, choose the primary 
I/O (the audio interface to which you are con-
necting your Legacy peripheral).

4  From the Main page, select the Legacy I/O but-
ton in the Port Settings.

5  From the Peripherals list, select “> <No Inter-
face>.”

6  From the Interface pop-up, select your I/O.

Hardware Setup dialog for 96 I/O, Analog Out page
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7  After the Hardware Setup dialog updates, 
choose your I/O in the Peripherals list. The Leg-
acy I/O is now ready to be configured.

Configuring I/O Setup

The I/O Setup dialog provides a graphical repre-
sentation of the Hardware Setup. Each I/O at-
tached to your system is displayed, with con-
trols to route physical ports to Pro Tools inputs 
and outputs. These controls mirror the routing 
controls found in Hardware Setup. Changes 
made to physical routing in one dialog, are al-
ways reflected in the other. I/O Setup also lets 
you label and map Pro Tools input, output, in-
sert, and bus signal paths.

Pro Tools ships with default I/O Setup settings 
that will get you started. You only need to go to 
I/O Setup if you want to remap or rename the 
default I/O paths.

To configure I/O routing in I/O Setup:

1  Choose Setups > I/O Setups in Pro Tools.

2  Map and name paths as desired.

3  If necessary, redefine formats for I/O channels 
of any peripherals.

For more information on Hardware Setup 
parameters for each I/O, refer to the periph-
eral’s guide.

Refer to the Pro Tools Reference Guide for 
more information on setting up I/O paths.



Routing a Pro Tools Output Pair to 
Multiple Audio Interface Output Ports

Pro Tools channel pairs can be routed to multi-
ple outputs on your Digidesign audio interface 
through Hardware Setup. 

This lets you have the same signal (such as a ste-
reo pair, a stem mix, or a multichannel mix) 
sent to multiple destinations (such as multiple 
mastering devices). Instead of doing multiple 
bounces or mix passes, each to a discrete device 
or output, or daisy-chaining devices, Hardware 
Setup allows you to “mirror” the Pro Tools out-
put and provide multiple channels of the same 
signal to different I/O ports. For example, if you 
assign Analog 1–2 and Digital [Encl] (AES/EBU, 
S/PDIF) in Hardware Setup to Pro Tools Output 
pair 1–2, when you select Pro Tools Output 1–2 
(as defined in I/O Setup), the audio will be 
routed to all three outputs with a single dual 
channel assignment.

Pro Tools output pairs can also be routed to 
multiple audio interface outputs in I/O Setup.

To select multiple output ports for a Pro Tools 
output channel pair:

1  Choose Setups > Hardware Setup in Pro Tools.

2  From the Peripherals list, select the desired in-
terface.

3  Make sure Main page tab is chosen.

4  Select an output pair.

5  Ctrl+Shift an additional output destination.

The output name updates with a plus sign (“+”) 
before it.
To verify which output ports have been routed, 
select the original output: In the pop-up menu, 
each output assigned to the Pro Tools output 
channel pair will have a check mark next to it.

6  Select additional output destinations, as de-
sired. The only limit to output choices is the 
number of outputs available in your system.

Hardware Setup dialog for 192 I/O, Main page
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chapter 3

Windows Configuration
To configure your Pro Tools|HD system for Win-
dows, you will need to install Pro Tools hard-
ware and software, verify your TDM system, 
then launch Pro Tools.

Installing Pro Tools Hardware

Pro Tools TDM Cards

The number of Pro Tools TDM cards will differ 
depending on your system configuration. Card 
components for each configuration are listed 
below.

Pro Tools|HD Hardware

Pro Tools|HD hardware comes in three configu-
rations:

Pro Tools|HD 1 Includes a single HD Core card.

Pro Tools|HD 2 Includes an HD Core card, an HD 
Process card, and a TDM FlexCable for connect-
ing the HD Core to the HD Process card.

If you are using an Expansion Chassis to 
add additional cards to your system, refer to 
the Expanded Systems Guide included with 
your Pro Tools system.
Pro Tools|HD 3 Includes an HD Core card, two 
HD Process cards, and two TDM FlexCables (one 
for connecting the HD Core to the first HD Pro-
cess card, and the other for connecting the first 
HD Process card to the other HD Process card).

The HD Core Card

The HD Core card provides up to 96 tracks of di-
rect-to-disk recording and playback, and 32 
channels of I/O to your Pro Tools HD-series sys-
tem, as well as DSP power for processing and 
mixing. The HD Core card supports up to 24-bit 
and up to 192 kHz sessions.

This card includes a single DigiLink port for con-
necting up to 32 channels of I/O. 

HD Core card

DigiLink
port

DigiSerial 
port
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The DigiSerial port is for connecting a Digide-
sign SYNC I/O. This connector is an 8-pin mini-
DIN.

The HD Process Card

The HD Process card provides DSP power for 
mixing, processing, and DSP software such as 
the DigiRack plug-ins included with Pro Tools. 
It also provides a DigiLink port for connecting 
up to 32 channels of I/O. 

The DigiSerial port on an HD Process card does 
not offer any functionality.

The DigiSerial port on HD Core cards does 
not support MachineControl connections. 
Use the Digidesign SYNC I/O for Pro Tools 
MachineControl 9-pin. A serial port (not a 
DigiSerial port) is required for MC Remote 
mode (only). For a list of qualified serial 
port adapters (such as USB), see:

www.digidesign.com/compato

HD Process card

DigiLink
port

DigiSerial 
port
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The TDM FlexCable

The TDM FlexCable is used to connect a pair of 
cards in your Pro Tools system so they can share 
data along the TDM bus. Additional FlexCables 
are required to connect additional cards. One 
FlexCable comes with each HD Process card.

Installing the Pro Tool|HD Cards

This section shows how to install Pro Tools HD 
cards into a Windows CPU. If you're installing 
cards into an expansion chassis, see the Ex-
panded Systems Guide.

Before you begin to physically install your 
Pro Tools cards, we recommended you tempo-
rarily disable the warning option, “Display a 
message before installing an unsigned file.” This 
expedites and automates much of the installa-
tion process. If you do not temporarily disable 
the warning, warning messages (that you are in-
stalling an unsigned driver) appear after each 
DSP chip during the detecting Pro Tools phase 
of installation. 

The TDM FlexCable is actually a flexible 
printed circuit board with delicate traces. 
Do not overbend the cable, twist it, or oth-
erwise pinch it. Doing so may cause unpre-
dictable behavior in Pro Tools as well as 
harm to your system.

TDM FlexCable, shown properly bent



To temporarily disable the warning option:

1  Turn on your computer. 

2  Right-click the My Computer icon located on 
your Windows desktop. 

3  Choose Properties.

4  Select the Hardware Tab.

5  In the Device Manager section of the dialog 
box that appears, select the Driver Signing but-
ton.

6  In Driver Signing Options, select “Ignore – In-
stall All Files Regardless Of File Signature.”

7  Click OK twice.

8  Turn your computer off.

9  Proceed with physically installing your 
Pro Tools cards.

To install the Pro Tools cards:

1  Turn off your computer and any peripherals. 
Turn off your computer and any peripherals. 
Make sure the equipment is properly grounded. 

2  Disconnect all cables attached to the CPU 
(such as hard drives, monitor(s), USB and 
firewire connections) except for power.

3  Open the computer case.

4  Remove the metal access port cover behind 
the PCI slot you want to use by removing the 
screw and sliding the cover out from the access 
port. Keep the screws in a safe place.

Before handling any card, discharge any 
static electricity that may be on your clothes 
or body by touching a grounded metal sur-
face, such as the power supply case inside 
your computer.
5  Install the HD Core card into the lowest num-
bered slot inside the CPU as shown in the fol-
lowing figures. The HD Core card will always be 
installed in the lowest numbered PCI slot. 

Make sure the first card is an HD Core card. HD 
Process cards cannot occupy the lowest slot.

6  Install HD Process cards in the following slots.

7  If installing a SCSI HBA card, install it in the 
highest numbered remaining slot.

8  If installing other cards, verify that your cards 
are installed in the following order, starting with 
the lowest numeric slot.

For each Pro Tools TDM system, your cards 
should be installed in the following order, start-
ing with the lowest numeric slot.

• HD Core cards

• HD Process cards

• SCSI host bus adapter (HBA)

• Video capture cards

• Display card for your computer monitor

9  If installing an HD Core system (and not a 
Pro Tools|HD 2 or HD 3 system), complete the 
following:

• Secure the card in place with the slot access 
port screw you removed earlier.

• Close the computer case.

• Skip the following steps and continue with 
“Connecting Audio Interfaces” on page 34.

10  If installing a Pro Tools|HD 2, HD 3, or an Ex-
panded HD 1 system, connect the HD cards with 
TDM FlexCables (see “Connecting Multiple 
Cards with the TDM FlexCable” on page 32).

The guidelines below may include optional 
cards not present in your system.
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Connecting Multiple Cards with the TDM 
FlexCable

Each HD card has two ports along the top of the 
card, labelled Port A and Port B. 

When installing multiple HD cards, data com-
munication across HD cards is achieved by us-
ing a TDM FlexCable to connect Port B of the 
lead card to Port A of the next card. The FlexCa-
ble has two connectors, also labeled Port A and 
Port B, to ensure proper connection.

To connect HD cards with the TDM FlexCable:

1  Make sure you have secured cards with the 
slot access port screws you removed earlier.

2  The FlexCable needs to be shaped before in-
stalling it on your HD cards. To do this, grasp it 
with both hands, then move the Port A portion 
of the cable straight towards you and inwards, as 
shown below. Do not bend the cable more than 
you need to, as you may damage the traces in 
the cable.

3  Slide the FlexCable into the notch of the sec-
ond card, so that the Port B connector of the 
FlexCable can be aligned with Port B of the lead 
card; and the Port A connector of the FlexCable 
can be aligned with Port A of the second card (as 
shown in the following diagram).

Preparing TDM FlexCable for installation

PORT A PORT B PORT A

PORT B
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4  Connect the Port A connector of the FlexCa-
ble to Port A on second card. Push down gently 
but firmly until the cable is fully connected to 
the card. Next, attach the other end of the Flex-
Cable (labeled Port B) to Port B on the lead card.

5  Verify the connection, as shown below.

6  For systems with more than two cards, each 
additional card must be connected to its preced-
ing card. Use FlexCables to connect cards to-
gether, as described above, until all cards are 
connected. Each subsequent HD Process card 
will include a FlexCable.

Inserting TDM FlexCable

Top view of two HD cards connected with TDM FlexCable

Side view of two HD cards connected with TDM 
FlexCable

PORT B

PORT B

PORT A

PORT A

PORT B

PORT A

PORT A

PORT B

PORT B

PORT B

PORT A

PORT A

PORT B

PORT B

PORT A

PORT A

PORT B

PORT APORT A

PORT B



Connecting Multiple Cards with the 
Female-to-Female TDM FlexCable

Some computers have a gap between PCI slots 
that exceeds the length of the TDM FlexCable. 
For such computers (for example, the IBM Intel-
liStation E Pro 6846), you will need a special 
adapted cable (the female-to-female TDM Flex-
Cable, in conjunction with a regular TDM Flex-
Cable) to connect multiple HD Process cards. To 
obtain the Female-to-Female TDM FlexCable, 
please contact Digidesign’s Technical Support:

tel: 650-731-6100

tel: 650-856-4275

Detecting Pro Tools Cards

To detect Pro Tools Cards:

1  Start or restart or your computer.

2  Start up Windows, logging in with Adminis-
trator privileges.

3  The Found New Hardware Wizard dialog pops 
up automatically. Click Next. If Digidesign DSP 
devices are found and installed automatically, 
skip to step 13.

4  Select the “Search For A Suitable Driver For My 
Device (Recommended)” option in the Install 
Hardware Device Drivers dialog. Click Next.

5  In the Locate Driver Files dialog, check (only) 
the CD-ROM option under Optimal Search Lo-
cations. Click Next. 

6  In the Locate File window, select the Drivers 
folder (on your Pro Tools CD-ROM). Click 
Open. 

7  Open “dalwdm.inf” or “dalwdm.”

8  Click OK in the Found New Hardware Wizard 
dialog. 
9  Click Next to install the multimedia controller 
in the Driver Files Search Results dialog.

10  Click Yes in the Digital Signature Not Found 
dialog, if present.

11  Click Finish in the Completing Found New 
Hardware dialog (indicating that a DSP is found.

12  Repeat step 10 for each DSP chip found. 
There are 9 chips on each HD Core card.

13  Re-enable the warning option, “Display a 
message before installing an unsigned file.” See 
“Installing the Pro Tool|HD Cards” on page 30.

14  You are now ready to install Pro Tools Soft-
ware.

If you do not follow the steps above or if you 
cancel any of the steps, your computer may not 
recognize your Pro Tools cards and you may re-
ceive the error message, “Cannot Create DAE 
Deck.” To resolve this error message, see “Can-
not Create DAE Deck Or Error Number 4” on 
page 41.

The complete Pro Tools software installation 
process includes:

• Un-installing any previously installed ver-
sions of Pro Tools.

• Upgrading to Windows 2000, or Windows XP.

• Preparing your computer for Pro Tools.

• Installing Pro Tools software.

The first time you launch Pro Tools after soft-
ware installation, will be prompted to enter 
your Pro Tools authorization code and config-
ure hardware. Instructions for this begin in 
“Launching Pro Tools the First Time” on 
page 43.

Before you begin installing Pro Tools software, 
Pro Tools hardware should already be installed. 
For more information, see “Installing Pro Tools 
Hardware” on page 29.
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Connecting Audio Interfaces

Each interface supplies up to 16 channels of in-
put and output to your system.

Pro Tools|HD supports up to a maximum of 
eight 192 I/Os or 96 I/Os.

Each HD card supports up to 32 channels; to get 
a full 32 channels of I/O from one card, you can 
connect, or daisy chain, a second 16-channel 
HD I/O to the first HD I/O that is connected di-
rectly to the HD card.

For example of connecting multiple HD I/Os, 
see Figure 1 on page 13 and Figure 2 on page 14.

In addition, previous generations of audio inter-
faces can be connected to the 192 I/O or 96 I/O. 
These include: 888|24 I/O, 882|20 I/O, 
1622 I/O, 24-bit ADAT Bridge I/O, and the orig-
inal ADAT Bridge I/O. The original 888 I/O and 
882 I/O interfaces are not supported with 
Pro Tools|HD. 

HD audio interfaces need room at their 
sides to maintain proper air flow for cool-
ing. It is important to leave room for air in-
take and ventilation on the sides of the unit. 
Do not block the sides of the unit or discon-
nect the internal fan. If the units are racked 
up in a case, remove all lids and/or doors 
before operating the system. Failure to do so 
can result in the units overheating very 
quickly, which can permanently damage 
sensitive components.
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To connect the HD audio interfaces:

1  If using a single 192 I/O or 96 I/O, connect it 
to the HD Core card with the provided DigiLink 
cable that came in the HD Core packaging. You 
must attach at least one 192 I/O or 96 I/O to 
your system in order for Pro Tools to boot.

2  Connect additional HD audio interfaces to 
subsequent Digidesign audio cards or daisy 
chain your I/Os (by connecting a secondary I/O 
to the primary I/O).

If you are connecting both 192 and 96 I/O audio 
interfaces to your system, connect the 192 I/O 
to your HD Core card, followed by any addi-
tional 192 I/O interfaces connected to the next 
highest-priority cards. Then connect the 96 I/O 
interfaces to subsequent cards.

You can also connect a single HD I/O to each HD 
card in your system using the provided DigiLink 
cables. There is no advantage to this configura-
tion over daisy chaining I/Os.

3  If using two or more HD audio interfaces, con-
nect the Loop Sync Out of each interface to the 
Loop Sync In of the next interface with the BNC 
cables included in your HD I/O packaging. 
Then, connect the Loop Sync Out of the last in-
terface to the Loop Sync In of the primary inter-
face.

4  If connecting a Digidesign Legacy audio inter-
face (such as an 888|24 I/O, 882|20 I/O, 
1622 I/O, or Digidesign ADAT Bridge I/O), con-
tinue with “Connecting an Additional 16 Chan-
nels of Audio to Legacy I/Os” on page 35. 

If you have at least one 192 I/O in your sys-
tem configuration, it must be connected to 
the HD Core card as the “primary” inter-
face.



Connecting an Additional 16 Channels 
of Audio to Legacy I/Os

Each 192 I/O and 96 I/O can support 16 chan-
nels of audio to and from Digidesign Legacy pe-
ripherals. These include: 888|24 I/O, 882|20 I/O, 
1622 I/O, 24-bit ADAT Bridge I/O, and the orig-
inal ADAT Bridge I/O. The original 888 I/O and 
882 I/O interfaces are not supported with 
Pro Tools|HD.

To connect Digidesign Legacy I/Os:

1  Connect the “MIX card” end of the peripheral 
cable that came with your Legacy I/O (60-pin 
side) to the Legacy Port on the primary HD au-
dio interface. Connect the other end to the 
Computer Port on the Legacy I/O. Connect ad-
ditional Legacy I/Os, if any, in the same manner, 
to HD audio interfaces connected directly to HD 
Process cards.

If using a Y cable or 16-channel peripheral cable 
adapter, connect this to the Legacy port first, 
then connect the audio interface peripheral ca-
bles to Port A and Port B of the Y cable.

Optional 16-channel peripheral cable adapter

“A” to first
Legacy I/O

“B” to second
Legacy I/O

to Legacy Port on
HD audio interface
2  In order to properly clock the Legacy device, 
you will need to connect the Ext. Clock output 
port on the HD I/O to the Slave Clock IN on the 
Legacy peripheral. The Legacy peripheral will 
switch to Slave mode once the proper clock is 
outputting from the HD I/O. Always use the Ext. 
Clock Out port of the same I/O to which the 
Legacy peripheral is attached.

If using multiple MIX-series audio interfaces, 
connect the Slave Clock Out of the first interface 
to the Slave Clock In of the second interface 
with the provided BNC cable. If using three 
888|24 or other MIX-series I/Os, the third 
888|24 would get its 256x clock from the second 
HD I/O to which it is attached.

Installing Pro Tools Software
The complete Pro Tools software installation 
process includes:

• Upgrading to Windows 2000 or XP

• Configuring your computer

• Installing Pro Tools software

After software installation is completed, the first 
time you launch Pro Tools you will be prompted 
to enter your Pro Tools authorization code and 
configure hardware. Instructions for this begin 
in “Checking Your TDM System and Launching 
Pro Tools” on page 41.

Before you turn on and configure your Leg-
acy I/O, turn down the volume of output de-
vices. Very loud digital noise may be emit-
ted before the Legacy I/O is initialized.

If you haven’t already installed Pro Tools 
hardware, do so now. See “Installing 
Pro Tools Hardware” on page 29 for in-
structions.
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Upgrading to Windows 2000 with 
IBM IntelliStation M Pro Model 
6889 

If you are using IBM’s IntelliStation M Pro 
Model 6889 and downgraded from Windows 
2000 to Windows NT (to be compatible with 
Pro Tools 5.0.1), you will need to recover Win-
dows 2000. 

To recover Windows 2000:

1  If you have an IDE boot drive, you must dis-
able “Onboard SCSI” in your BIOS before start-
ing the recovery process, as follows:

• Access “Devices and I/O Ports.”

• Set “Onboard SCSI” to disabled.

When you have completed the following recov-
ery steps fully, you can re-enable “Onboard 
SCSI.”

2  Start or restart your computer.

3  Press F11 during the message, “To start the 
IBM product recovery program, press F11.” This 
message appears briefly, so you will need to be 
quick. If you miss it, allow the E Pro to boot into 
Windows and restart again.

4  Select Full Recovery of Windows 2000 in the 
“IBM Product Recovery Program.”

5  Follow the on-screen instructions. You will be 
warned that the recovery process will erase ev-
erything on that drive. The recovery process 
takes about 40 minutes. 

6  You now have Windows 2000. Proceed to con-
figuring your computer.

Make sure you back up important files be-
fore recovering Windows 2000.
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Configuring Your Computer

To ensure optimum performance with 
Pro Tools, configure your computer before in-
stalling the Pro Tools software.

There are five parts to configuring your computer:

1  Configuring your BIOS.

2  Configuring your SCSI BIOS.

3  Installing the SCSI drivers.

4  Setting Display Performance.

5  Setting Application Response. 

Configuring Your BIOS

BIOS (Basic Input/Output System) parameters 
vary depending on the make and model of the 
computer. Refer to the documentation that 
came with your computer for more details.

Different BIOS manufacturers often use differ-
ent names to describe the same system function. 
Some manufacturers do not provide a particular 
configuration option at all. Consequently, the 
names and options that appear in your com-
puter’s BIOS may differ from those described in 
this guide. 

Before you make any changes to your com-
puter’s system settings, make a backup copy 
of your Registry (where many of these essen-
tial settings are stored). By doing so, you 
will be able to restore your system’s original 
settings in case of trouble. See your Win-
dows User’s Guide for details. 

If your computer does not provide the BIOS 
configuration options included in this sec-
tion, or if you do not feel comfortable 
changing system parameters or deleting 
drivers, consult with a Windows system ad-
ministrator, or your computer dealer or 
manufacturer for assistance. 



To modify your computer’s BIOS:

1  Start or restart your computer. 

2  During power up, enter BIOS Setup by press-
ing the appropriate key on your computer key-
board. On most computers, this is F1, F2, or the 
Delete key. Refer to the documentation that 
came with your computer. 

3  When you are in BIOS Setup, disable Plug & 
Play OS, if present.

4  Disable PCI Parity, if present.

5  Enable SCSI support, if your computer is 
equipped with built-in SCSI hardware. SCSI sup-
port parameters are typically found on the De-
vices & I/O Options page of the BIOS setup 
utility. If you do not have built-in SCSI hardware 
and using a SCSI host adapter card instead, you 
do not need to set this setting.

6  Disable Power Management, if present.

7  Enable PCI Dynamic Bursting, if present.

8  Enable PCI Master 0 WS Write, if present.

9  Disable PCI Delay Transaction, if present.

10  Disable PCI#2 Access #1 Retry, if present. 

11  Save settings.

12  Exit BIOS setup and restart your computer.
Configuring Your SCSI BIOS

In addition to configuring your BIOS, you must 
also modify the settings of your built-in SCSI 
hardware or SCSI adapter card. This allows SCSI 
hard drives to work properly with Pro Tools. 
This procedure varies on different computers. 
Consult your computer’s User Guide. 

To modify your computer’s SCSI BIOS:

1  Start your computer. If your computer is al-
ready on, restart it. 

2  During power up, when the text message re-
garding the SCSI BIOS appears, press the key 
combination listed on the screen to enter the 
SCSI BIOS. The SCSI BIOS setup utility appears.

3  Consult your SCSI host bus adapter’s User 
Guide to set the following parameters:

• Maximum Sync Transfer Rate parameter to 
20 MB/sec for each SCSI ID and SCSI chan-
nel connected to your audio drives. 

• If you are using an ATTO HBA, change the 
PCI Burst Size to 32 Bytes. 

• If you are using an Adaptec HBA, enable 
the Host Adapter BIOS option.

4  Save these settings.

5  Exit SCSI BIOS setup and restart your com-
puter.

If you are using the ATTO EPCI-DC card 
that came in Digidesign’s SCSI64 Kit, these 
parameters are already set correctly for use 
with Pro Tools.
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Installing the ATTO or Adaptec SCSI 
Drivers

Pro Tools requires the use of SCSI host adapters 
and SCSI drives. For Pro Tools to run at maxi-
mum efficiency with these devices, install the 
Digidesign approved SCSI driver (ATTO or 
Adaptec, depending on the card you are using). 

The full name of the ATTO driver is:

■ ATTO ExpressPCI

The full name of the Adaptec drivers for the IBM 
M Pro is:

■ Adaptec 
AHA290/291/294x/394x/4944/AIC78xx

If you need to install the ATTO or Adaptec 
driver, consult the driver manufacturer’s docu-
mentation.

Setting Display Performance

Configure your computer’s video display for op-
timal performance with Pro Tools. You can 
avoid disk performance issues by changing two 
video display parameters on your system.

To change video display parameters:

1  Right-click on the desktop.

2  Go to Properties.

3  Select the Settings tab. 

4  Go to Advanced.

5  Select the Troubleshooting tab.

Check Digidesign’s Compatibility Docu-
ments for a list of Digidesign approved com-
puters and supported SCSI driver versions:

www.digidesign.com/compato
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6  Disable all accelerations by manually moving 
the slider to None (from its default setting of 
Full).

7  Click OK.

8  For Windows 2000, select the Effects tab.

9  For Windows XP, select the Appearance tab, 
click the Effects button, and uncheck the “Use 
the following transition effect for menus and 
tooltips.”

10  Deselect the Show Windows Contents While 
Dragging box.

11  Click OK.

Specific settings vary, depending on the type of 
video card in your computer. For a complete list 
of compatible video cards and their settings, re-
fer to the latest compatibility information on 
the Digidesign web site:

www.digidesign.com/

Setting Application Response

The final step in configuring your computer is 
setting your system’s Application Response pa-
rameter. 

To configure Application Response (Windows):

1  From the Start Menu, choose Settings > Con-
trol Panel. 

2  Double-click on System.

3  Click the Advanced tab. 

4  Click Performance Options. 

5  Under Application Response select Back-
ground Services.

6  Click OK, twice.



To configure Application Response (Windows XP):

1  From the Start Menu, choose Control Panel. 

2  Double-click on System.

3  Click the Advanced tab. 

4  Under Performance, click Settings.

5  Click the Advanced tab.

6  Under Processing Scheduling, set to Back-
ground Services.

7  Click OK, twice.

Installing Pro Tools Software

To install Pro Tools software:

1  If you are using virus-protection software, 
turn it off or remove it and restart your com-
puter. Avoid running virus-protection software 
while using Pro Tools since it adversely affects 
system performance.

2  Place the Pro Tools Installer CD for Windows 
in your CD-ROM drive. Locate and double-click 
the blue icon named “Setup.”

3  Click Next.

4  Click OK to accept the License Agreement. 

5  Select the hard drive on which to install 
Pro Tools from the Install pop-up menu. For 
maximum reliability, install Pro Tools on your 
startup drive. 

6  Click Next.

To install Pro Tools, you must log on to 
Windows as Administrator. If you do not 
have Administrator privileges or do not 
know how to set them up, see your Win-
dows User’s Guide.
7  We recommend you choose the Typical Install 
option. However, if you Custom Install, the next 
window will ask you to choose the options you 
want to install. To install any of these items, se-
lect them from the following list: 

Program Files This component contains the 
Pro Tools executable and all support DLLs.

Plug-Ins This component contains the core plug-
ins. These files are required by Pro Tools.

Controllers This component contains the 
Pro Tools Control Surface Personalities.

Documentation This component contains 
Pro Tools documentation and release notes.

System Files This component contains Digide-
sign System Files. These files are required by 
Pro Tools.

Pro Tools Utilities This component contains the 
DigiTest utility and calibration test tones.

Acrobat Reader This component contains the 
Acrobat 4.0 Reader installer.

Codecs This component contains the Pro Tools 
Audio Codecs: MP3, RealAudio, and Windows 
Media.

Answerbase This component contains stand-
alone Pro Tools multi-lingual information data-
bases. Note that these files require approxi-
mately 37 MB of disk space.

8  Click Next. 

 MacOpener is included on the Pro Tools in-
staller CD-ROM disk and requires a sepa-
rate installation process.
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9  Select a “work environment.” This is an initial 
set of Pro Tools Preferences. These Preference 
“sets” have been pre-configured to include some 
of the more popular settings for post produc-
tion, audio, and audio with MIDI. Click Next.

Selecting a Pro Tools Preference

Preference settings can be customized at any 
time in Pro Tools. See the Pro Tools Refer-
ence Guide for more information about Pref-
erences.
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10  Select whether to install the Surround Mixer 
plug-in. This plug-in is required for mixing, 
mastering, and monitoring in surround. For Sur-
round systems, select Yes – Monitoring Pro Tools 
Film Format if your monitoring is configured for 
Film Format, or select Yes – Monitoring in Pro-
Control (DTS Format) if using a ProControl ded-
icated controller. Select No – Stereo mixing only, 
if your monitoring is configured for Stereo. After 
making a selection, click Next.

11  When installation is complete, click Finish to 
restart your computer.

Using MIDI

Pro Tools in Windows uses your Multimedia 
Setup to configure MIDI devices and their prop-
erties. Refer to your device’s installation and us-
age documentation to properly configure the 
device.

Selecting a Pro Tools Preference



Cannot Create DAE Deck Or Error 
Number 4

Your computer may not recognize your 
Pro Tools cards if you did not follow all of the 
steps above, or if you upgrade from Windows 
NT to Windows 2000 or Windows XP.

If you receive error message number 4 or “Can-
not Create DAE Deck,” when you launch 
Pro Tools, complete the instructions below.

To correct a “Cannot Create DAE Deck” 
error:

1  Turn your computer off. 

2  Confirm that all your Pro Tools cards are 
seated correctly and cables are tightly fastened. 

3  Start your computer and launch Pro Tools. If 
the error does not re-appear, you do not need to 
continue with these steps.

4  With your computer on, right-click the My 
Computer icon (located on your Widows desk-
top). 

5  Choose Properties > Hardware > Device Man-
ager.

6  Expand the Sound, Video and Game Control-
lers list.

7  In Multimedia Devices, you should see an “!” 
icon next to each Pro Tools DSP chips that is not 
properly installed.

8  Select one of these “!” icons and press Delete. 
Click OK in the Confirm Device Remove dialog. 

9  Repeat the previous step for each of these “!” 
icons, until they are all removed. Then, click 
OK.

10  You are ready to install your Pro Tools cards. 
See “Detecting Pro Tools Cards” on page 33.
Checking Your TDM System 
and Launching Pro Tools
Before you launch Pro Tools, run the DigiTest di-
agnostics application located in the Digidesign 
Utilities folder (see “Running DigiTest” on 
page 42). DigiTest finds your cards and confirms 
that they are correctly installed and working.

When DigiTest has completed and you have re-
booted your computer, launch Pro Tools for the 
first time.

Starting Up Your System

Whenever you start your system, you must turn 
on all of your system components in a specific 
order.

Start your Pro Tools System in this order:

1  Make sure all your equipment (including your 
CPU) is off.

2  For TDM systems with an expansion chassis, 
turn on the expansion chassis.

3  Turn on external hard drives, if any. Wait ap-
proximately ten seconds for them to spin up to 
speed.

4  Lower the volume of all output devices, then 
turn on your Pro Tools audio interfaces.

5  Turn on any MIDI interfaces and devices, or 
synchronization peripherals.

6  Turn on your Pro Tools audio interfaces (such 
as 96 I/O). On power up, the status LEDs will 
flash. Wait at least fifteen seconds for the audio 
interface to initialize, and the status LEDs to 
stop blinking and stay lit.
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If you launch Pro Tools without turning on your 
audio interfaces, you will be prompted to turn 
them on. Allow fifteen seconds for audio inter-
faces to power-up and the status LEDs to stop 
blinking and stay lit, before clicking OK.

7  Turn on your computer. 

Running DigiTest

Run the DigiTest diagnostics application to 
identify TDM cards and verify that they are cor-
rectly installed and working.

To run DigiTest:

1  Turn off Pro Tools. 

2  Go to Start > Programs > Digidesign > 
Pro Tools > DigiTest. 

3  Test cards.

• To test only one Digidesign card in your sys-
tem, click the button that corresponds to this 
card. 

• To test all Digidesign cards at once, press the 
“Test All Cards” button. 

DigiTest is included on the Pro Tools In-
staller CD and installed with Pro Tools. 
DigiTest resides in the Digidesign Utilities 
folder located in your hard drive, in the sub-
directory Digidesign/Pro Tools/Pro Tools 
Utilities.

Before you run DigiTest, lower the volume 
of all output devices. Very loud digital noise 
may be emitted during the test.
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4  When prompted, recycle power on all 
Pro Tools peripherals. Press Continue.

5  Check the “Test I/O Box.”

6  Exit DigiTest by clicking on the “close” box on 
the top right hand corner of the application 
window. 

7  Reboot your computer. 

Errors and Undetected Cards

Complete the steps below if:

■ There is a problem with a component in your 
system and an error message has been displayed 
to the right of the corresponding card’s button 
in DigiTest.

– or –

■ A supported card is installed but not automat-
ically detected during DigiTest.

If a supported card is installed and is not 
automatically detected:

1  Close DigiTest.

2  Power down your system.

3  Reinstall the cards (see “Installing the 
Pro Tool|HD Cards” on page 30).

4  Check the card seating.

5  Check the ribbon cable connection.

6  Power up. 

7  Begin DigiTest again.

LEDs on your digital interfaces may light up 
during this test. This is normal. Continue to 
test. 



For descriptions of all error codes, refer to 
Appendix B, “DigiTest Error Codes.” For test de-
tails, click the Info button to the right of the re-
ported error, then click Failures in the pop-up 
window and change Failures to Detailed.

If a card continues to fail DigiTest, contact 
Digidesign Technical Support.

tel: 650-731-6100

tel: 650-856-4275

Launching Pro Tools the First Time

Validate Pro Tools Software

When launching Pro Tools the first time, you 
are prompted to enter an authorization code to 
validate your software.

To validate Pro Tools software:

1  Double-click the Pro Tools application in the 
Pro Tools folder inside the Digidesign folder.

2  Enter the authorization code in the dialog 
when prompted, making sure to observe any 
spaces, then click Validate.

The authorization code is located on the inside 
cover of this guide.

Congratulations! Pro Tools is launched. When 
Pro Tools is launched for the first time only the 
menus will appear. To see Edit and Mix win-
dows, a new session must be created. But before 
you begin working with Pro Tools, you should 
get acquainted with Pro Tools system settings, 
described in the following section.

Authorization code validation for Pro Tools
Configuring Pro Tools

Configuring the Playback Engine

The Playback Engine sets the voice count (and 
voiceable tracks) for your system, and it’s ses-
sions. Additionally, it lets you customize various 
System Usage parameters (such as buffers, CPU 
Usage).

To configure the Playback Engine:

1  Choose Setups > Playback Engine.

2  From the H/W Buffer Size pop-up, select the 
audio buffer size, in samples, for host processing 
tasks such as Real-Time AudioSuite (RTAS) plug-
in processing. The default setting is 512 sam-
ples. Select a higher setting if you need more 
buffer time for RTAS, HTDM, and Direct Con-
nect applications.

3  From the CPU Usage Limit pop-up, select the 
maximum percentage of CPU resources to allo-
cate to host processing tasks. The default setting 
is 40%. Select a higher setting if you need more 
buffer time for RTAS, HTDM, and Direct Con-
nect applications.

Playback Engine dialog for Pro Tools TDM system

Increasing the CPU Usage Limit may slow 
down screen responses.
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4  From the Number of Voices pop-up, select the 
amount of voices (and voiceable tracks), for 
your sessions. The default number of voices on a 
Pro Tools|HD 1 system is 48 voices (at the de-
fault 48 kHz sample rate).

Depending on the current sample rate, and the 
number of HD Core and Process cards in your 
system, you will have different choices avail-
able. For example, each HD card allows you to 
use one or two of its DSPs per card for voicing.

Most DSP amounts support three levels of voice 
numbers:

• Select higher voice numbers when your 
cards are in your machine. You should also 
select higher voice numbers when using a 
chassis to run higher track counts at higher 
sample rates (such as 64 tracks at 96 kHz) 
and you want more voices (such as 16 
voices per DSP at 96 kHz).

• Select medium voice numbers when run-
ning cards in an expansion chassis, or 
when using other PCI cards along with 
Digidesign cards.

• Select minimum voice numbers if you are 
running high bandwidth PCI cards (such as 
video capture).

For voice limits on different HD systems, refer to 
the Pro Tools Reference Guide.

Changing the number of voices, along with 
sample rate, affects DSP usage and your 
system performance. Please read the follow-
ing carefully.
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5  From the Sample Rate pop-up, select the ses-
sion sample rate. This choice will not be avail-
able if a session is open. 

6  Set DAE Playback Buffer Size.

The DAE Playback Buffer Size determines the 
amount of memory allocated within DAE to 
manage disk buffers, which affects system per-
formance.

Though DAE automatically selects the optimal 
playback buffer size for your system, you may 
want to adjust this parameter to modify your 
system’s performance:

◆ Allocating a larger buffer size can sometimes 
allow for a higher density of edits. This can be 
useful if you experience system performance 
problems in sessions with a large number of ed-
its in rapid succession. However, choosing a 
larger buffer size can cause a time lag to occur 
before playback or recording begins. It can also 
cause a time lag to occur when you are editing 
during playback.

◆ Allocating a smaller buffer size can sometimes 
improve playback/recording initiation speed. 
This can be useful if you are experiencing a time 
lag when you initiate playback/recording. How-
ever, choosing a smaller buffer size can make it 
difficult for slower hard drives to play or record 
tracks reliably. 

7  Click OK, when finished.

Session sample rate can always be set in the 
Create a New Session dialog. (See the 
Pro Tools Reference Guide.)



Configuring Hardware Setup 
(Audio Interfaces)

Pro Tools HD peripherals support 16 channels 
of simultaneous I/O. The peripherals support 
multiple formats (such as analog, AES/EBU, 
TDIF, and so on). 

The Main page of the Hardware Setup dialog is 
where you define what physical ports are routed 
to Pro Tools input and output ports. Think of 
this window as a patchbay that allows you to 
route any of the physical inputs or outputs on 
your HD I/Os to channel assignments in the 
Pro Tools mixer.

The Main page also provides controls for session 
Sample Rate, clock settings, and defining 
whether Expansion Port or Legacy Port periph-
erals are active.

Additional pages are available to configure other 
parameters on each I/O (such as setting operat-
ing levels).

You must select the peripheral, then set the pa-
rameters for that interface—repeating this for 
each interface in your system. 

Hardware Setup dialog for 192 I/O, Main page

Use the Up and Down Arrow keys to scroll 
though each peripheral.
To validate audio interfaces with the Identify 
button:

1  Choose Setups > Hardware in Pro Tools.

2  From the Peripherals list, select the Digidesign 
audio interface connected to the first card in 
your HD system. This will be the interface at the 
top of the list.

3  Make sure Main page tab is chosen.

4  Use the Identify button to verify that your au-
dio interface has been properly identified. Click 
on the Identify button, located in the lower left 
corner of the Hardware Setup dialog, to illumi-
nate all the LEDs on the front panel of the audio 
interface. If the LEDs do not light, make sure the 
interface is selected in the Peripherals list, and 
that it is powered on. If the LEDs continue to 
not light, review hardware installation and run 
DigiTest again.

5  Repeat the above steps for additional audio in-
terfaces.

Legacy I/Os must be initialized in the Pe-
ripherals list before they can be validated 
with the Identify button. For initialization 
steps, see “Configuring Legacy I/Os” on 
page 49.
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To configure audio interfaces:

1  Choose Setups > Hardware in Pro Tools.

2  From the Peripherals list, select the Digidesign 
audio interface connected to the first card in 
your HD system. This will be the interface at the 
top of the list.

3  Make sure Main page tab is chosen.

4  To select a different digital I/O on your audio 
interface (enclosure), click on one of the format 
buttons, under Digital Format. Choices include: 
AES/EBU, S/PDIF, and Optical (S/PDIF). Select-
ing Optical (S/PDIF) resets the physical Optical 
I/O port (which is, by default, eight channels of 
ADAT I/O) to two channels of S/PDIF I/O. For 
more information about HD enclosure and card 
ports, refer to the guide for your I/O.

5  From the Clock Source pop-up, select the ap-
propriate clock source for the system. In most 
cases, you will use Internal. The other choices 
are for resolving Pro Tools to external clock 
sources. Depending on your audio interface, 
Clock Source options can include: AES/EBU 
[Encl], S/PDIF, Optical [Encl], AES/EBU 1–8, 
TDIF, ADAT, and Word clock (optional word 
clock rates are available at higher frequencies).

6  From the Ext. Clock Output, select the appro-
priate clock source to feed to devices attached to 
your I/O. 

If the Legacy Port is enabled (as opposed to 
the Expansion Port) then the Ext. Clock 
Output automatically switches to 
Slave256x. To reset the Ext. Clock Output, 
the Port Settings button must be set back to 
Expansion and the Legacy I/O must be set to 
No Interface. (To set a Legacy I/O to No In-
terface, select its name in the Peripherals 
list, then click on No Interface in the Inter-
face pop-up menu.)
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7  For S/PDIF compatibility with Tascam DA30 
DAT recorders, click on the Tascam button, un-
der S/PDIF Format.

8  From the input and output channel pop-ups, 
select the physical ports (such as Analog 1–2, 
Optical 1–2, and so on), that will be routed to 
the Pro Tools input and output ports (such as 
(Ch 1–2, 3–4, and so on).

Refer to your peripheral’s guide for sample rate, 
and other restrictions. For example, the Optical 
1–8 channels (on the enclosure) will not be 
available for session sample rates of 88.2 kHz or 
higher (whereas the ports on the 192 I/O Digital 
I/O card will be available).

To differentiate inputs and outputs of the same 
format, they are labeled differently in the input 
and output channel pop-ups. For example, the 
AES/EBU inputs and outputs that come standard 
in the 192 I/O enclosure are identified as 
AES/EBU [Encl]; the AES/EBU inputs and out-
puts that come on the factory-installed Digital 
port are listed (in pairs) as AES/EBU 1–2, 
AES/EBU 3–4, and so on. For 192 I/Os equipped 
with the optional Digital I/O Card, the addi-
tional AES/EBU I/O ports on the optional card 
are labelled AES/EBU 9–10, AES/EBU 11–12, and 
so on.

9  Configure controls specific to your HD I/O. 
See “Configuring 192 I/O Controls” on page 47 
and “Configuring 96 I/O Controls” on page 48.

10  For additional HD-series I/Os, choose the I/O 
in the Peripherals list, and repeat the above 
steps.



Configuring 192 I/O Controls

To configure controls specific to a 192 I/O:

1  With the 192 I/O selected in the Peripherals 
list, click on the Analog In tab for the following 
options:

• You can set your operating level by select-
ing Reference Level +4 dBu or –10 dBV, on 
a channel-by-channel basis, based on 
which physical inputs are routed to 
Pro Tools inputs. Refer to the 192 I/O 
Guide for more information.

• Each of the analog channels in the 192 I/O 
has two Input Trims, labelled A and B, for 
precisely calibrating and switching levels. 
Select Input Trim A or B on a channel-by-
channel basis. See the 192 I/O Guide for in-
formation on setting the rear panel trims.

• You can select Soft Clip on a channel-by-
channel basis. The Soft Clip limiter attenu-
ates the incoming analog signal, providing 
extra protection from temporary clipping 
transients that can cause digital distortion 
when they exceed the maximum input of 
the unit. With Soft Clip enabled, 192 I/O 
supports an additional 4 dB of headroom 
by rounding off the top 4 dB to the clip 
point. This is useful for eliminating stray 
transients or emulating analog tape satura-
tion.

Hardware Setup dialog for 192 Analog In page
2  Click on the Analog Out tab for the following 
option:

• Each of the analog channels in the 192 I/O 
has two Output Trims, labelled A and B, re-
spectively. You can select Input Trim A or B 
on a channel-by-channel basis.

3  On the 192 I/O with an optional Digital I/O 
card, click on the Digital tab, to set the Input 
Format and SR Conversion (real-time sample 
rate conversion).

Hardware Setup dialog for 192 I/O, Analog Out page

At session sample rates above 48 kHz, sam-
ple rate conversion for the TDIF and Optical 
(ADAT) inputs on the Digital I/O card is 
automatically enabled on all eight inputs of 
the selected format. 

Hardware Setup dialog for 192 I/O, Digital page
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Configuring 96 I/O Controls

To configure controls specific to a 96 I/O:

1  With the 96 I/O selected in the Peripherals 
list, configure your I/O front panel meters for in-
put or output metering from the Meters pop-up.

2  Click on the Analog In tab, for the following 
option:

• You can set your operating level by select-
ing Reference Level +4 dBu or –10 dBV, on 
a channel-by-channel basis, based on 
which physical inputs are routed to 
Pro Tools inputs. Refer to the 96 I/O Guide 
for more information.

Hardware Setup dialog for 96 I/O, Analog Out page
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3  Click on the Analog Out tab, for the following 
option:

• You can set your output level by selecting 
Reference Level +4 dBu or –10 dBV, on a 
channel-by-channel basis, based on which 
physical outputs are routed to Pro Tools in-
puts. Refer to the 96 I/O Guide for more in-
formation.

Hardware Setup dialog for 96 I/O, Analog Out page



Configuring Legacy I/Os

Repeat the above steps for any Legacy I/Os (such 
as 888|24 I/O) connected to the first I/O, then 
second, and so on. Before you can configure a 
Legacy I/O, it must first be initialized in Hard-
ware Setup.

To initialize a Legacy I/O:

1  Before you turn on and configure your Legacy 
I/O, turn down the volume of output devices. 
Very loud digital noise may be emitted before 
the Legacy I/O is initialized.

2  Power on your Legacy I/O.

3  From the Peripherals list, choose the primary 
I/O (the audio interface to which you are con-
necting your Legacy peripheral).

4  From the Main page, select the Legacy I/O but-
ton in the Port Settings.

5  From the Peripherals list, select “> <No Inter-
face>.”

6  From the Interface pop-up, select your I/O.

7  After the Hardware Setup dialog updates, 
choose your I/O in the Peripherals list. The Leg-
acy I/O is now ready to be configured.

For more information on Hardware Setup 
parameters for each I/O, refer to the periph-
eral’s guide.
Configuring I/O Setup

The I/O Setup dialog provides a graphical repre-
sentation of the Hardware Setup. Each I/O at-
tached to your system is displayed, with con-
trols to route physical ports to Pro Tools inputs 
and outputs. These controls mirror the routing 
controls found in Hardware Setup. Changes 
made to physical routing in one dialog, are al-
ways reflected in the other. I/O Setup also lets 
you label and map Pro Tools input, output, in-
sert, and bus signal paths.

Pro Tools ships with default I/O Setup settings 
that will get you started. You only need to go to 
I/O Setup if you want to remap or rename the 
default I/O paths.

To configure I/O routing in I/O Setup:

1  Choose Setups > I/O Setups in Pro Tools.

2  Map and name paths as desired.

3  If necessary, redefine formats for I/O channels 
of any peripherals.

Routing a Pro Tools Output Pair to 
Multiple Audio Interface Output Ports

Pro Tools channel pairs can be routed to multi-
ple outputs on your Digidesign audio interface 
through Hardware Setup. 

This lets you have the same signal (such as a ste-
reo pair, a stem mix, or a multichannel mix) 
sent to multiple destinations (such as multiple 
mastering devices). Instead of doing multiple 
bounces or mix passes, each to a discrete device 
or output, or daisy-chaining devices, Hardware 
Setup allows you to “mirror” the Pro Tools out-
put and provide multiple channels of the same 
signal to different I/O ports. For example, if you 
assign Analog 1–2 and Digital [Encl] (AES/EBU, 

Refer to the Pro Tools Reference Guide for 
more information on setting up I/O paths.
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S/PDIF) in Hardware Setup to Pro Tools Output 
pair 1–2, when you select Pro Tools Output 1–2 
(as defined in I/O Setup), the audio will be 
routed to all three outputs with a single dual 
channel assignment.

Pro Tools outputs pairs can also be routed to 
multiple audio interface outputs in I/O Setup.

To select multiple output ports for a Pro Tools 
output channel pair:

1  Choose Setups > Hardware Setup in Pro Tools.

2  From the Peripherals list, select the desired in-
terface.

3  Make sure Main page tab is chosen.

4  Select an output pair.

5  Ctrl+Shift an additional output destination.

The output name updates with a plus sign (“+”) 
before it.

To verify which output ports have been routed, 
select the original output: In the pop-up menu, 
each output assigned to the Pro Tools output 
channel pair will have a check mark next to it.

6  Select additional output destinations, as de-
sired. The only limit to output choices is the 
number of outputs available in your system.

Hardware Setup dialog for 192 I/O, Main page
Getting Started with HD



chapter 4

Connecting Your Studio
This chapter provides general information on 
connecting Pro Tools to your system, including 
digital equipment, effects units, MIDI gear, and 
SMPTE synchronization devices.

Refer to the 96 I/O Guide or the 192 I/O Guide for 
specific details regarding:

• Front and back panel connectors and indica-
tors

• Technical specifications

• On 192 I/O, installing optional cards

HD audio interfaces need room at their 
sides to maintain proper air flow for cool-
ing. It is important to leave room for air in-
take and ventilation on the sides of the unit. 
Do not block the sides of the unit or discon-
nect the internal fan. If the units are racked 
up in a case, remove all lids and/or doors 
before operating the system. Failure to do so 
can result in the units overheating very 
quickly, which can permanently damage 
sensitive components.
Setting Up Your Studio
Figure 3 illustrates a typical studio setup, with a 
192 I/O connected to a mixing console, effects 
and other equipment.

Figure 4 illustrates a setup without a mixer, 
where effects and monitoring gear are con-
nected directly to a 96 I/O.
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Example Studio Setup with a 
Mixing Console
Getting Started with HD
Figure 3.  Typical studio configuration using 192 I/O with mixer connections 
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Example Studio Setup 
without a Mixing Console
Figure 4.  Typical studio configuration using 96 I/O without a mixer
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192 I/O

The 192 I/O features two DB-25 breakout con-
nectors for two sets of eight inputs each, at 
+4 dBu and –10 dBV respectively. 

There are no –10 dBV outputs, however; analog 
outputs break out from a single DB-25 output at 
+4 dBu operating levels. 

The 192 I/O requires a custom DB-25 snake. 
Digidesign sells nine different DigiSnake (DB-
25) cables for this purpose. Contact your dealer 
or Digidesign for more information.

96 I/O

The 96 I/O analog connectors are TRS 1/4” with 
TIP wired hot (or “+”), RING cold (or “–”), and 
SLEEVE ground.

If connecting to unbalanced loads, use unbal-
anced TS cables.

There is one bank of eight inputs (software-swit-
chable between +4 dBu and –10 dBV line levels 
on a line-by-line basis).

There is one bank of eight outputs (that use 
+4 dBu line levels).

When driving unbalanced lines on the 192 
I/O output card, leave negative “–” termi-
nals disconnected. Failure to do so will re-
sult in noisy outputs.
Getting Started with HD
Connecting Equipment with 
Digital Audio Ins and Outs
Each Pro Tools HD I/O includes AES/EBU, 
S/PDIF, and ADAT digital options. The 192 I/O 
includes additional AES/EBU and optical ports, 
as well as TDIF, dual-wire AES/EBU at 192 kHz, 
and sample rate converters.

The following example provides basic setup 
guidelines for connecting to a DAT recorder. For 
detailed information for recording to and from 
an ADAT, see “Recording To and From Digital 
Devices” on page 72.

To connect your Pro Tools system to a DAT 
recorder:

1  Connect the AES/EBU or S/PDIF output on the 
enclosure to the AES/EBU or S/PDIF input of 
your DAT deck. By default, this port is assigned 
to Pro Tools Output 1–2.

2  Connect the AES/EBU or S/PDIF input on the 
enclosure to the AES/EBU or S/PDIF output of 
your DAT deck. Route the digital input to 
Pro Tools inputs in the Hardware Setup dialog.

You can route any of the physical input or 
output pairs to any of the input and output 
channel assignments in the Pro Tools 
mixer. Refer to the Pro Tools Reference 
Guide.

Pro Tools does not analyze the incoming 
sample rate across the digital ports. There-
fore, make sure the DAT tape or digital de-
vice is set for the same sample rate as Pro 
Tools. Otherwise, once you set the Clock 
Source back to Internal, the pitch will be off.



Connecting Effects Units
The 192 I/O and 96 I/O allow you to connect an-
alog or digital effects units to your Pro Tools sys-
tem, and use them as inserts or make them the 
destination for effects sends and returns.

Five inserts are available on each audio channel. 
Each insert can be a hardware insert (or software 
plug-in), and can be mono or stereo.

When using a hardware insert, you can connect 
the device to matching inputs and outputs on 
your system. For example, a stereo insert could 
use outputs 7–8 and inputs 7–8 for the sends 
and returns, respectively. Routing the physical 
inputs and outputs of the interface to Pro Tools 
inputs and outputs can be done in either the 
Hardware Setup dialog or I/O Setup dialog. From 
I/O Setup, inserts can also be defined, and their 
channels mapped to audio interface channels. 
For more information, see the Pro Tools Reference 
Guide).

You can also connect effects units to your sys-
tem by using any analog or digital inputs and 
outputs as Auxiliary Inputs and Outputs for ef-
fects sends and returns. Once an effects unit is 
attached this way, you can send a variable 
amount of a track’s output to the effects unit us-
ing a send fader in Pro Tools. 

Five separate send controls on each Pro Tools 
track allow you to route audio to any of the 
available outputs connected to your system or 
through any of the 64 internal busses in the 
Pro Tools TDM Mixer. Outputs can be returned 
to mono or stereo Auxiliary Inputs for auto-
mated mixing or processing.
When you are using an effect in this send-type 
of configuration, make sure the unit’s internal 
mix or balance between direct (unprocessed) 
and wet (effected) signal is set so that only the 
processed signal is returned to Pro Tools. On 
most effect units, a balance setting of 100% 
(completely wet) is the appropriate setting. 

If you’ve been using an effects unit in an instru-
ment setup, such as a guitar effects rack, you’ll 
probably find the balance to be below 50%. If 
the unit has separate dry and effect level knobs, 
turn dry level control off. If you don’t do this, 
the dry, unprocessed signal will be present in an 
effect’s output along with the desired processed 
sound, and you’ll have trouble accurately con-
trolling the effect balance in your final mix. 

Connecting Effects Units Digitally

To use your audio interface’s inputs and outputs 
as effects sends and returns to a digital effects 
device, set your interface’s Clock Source to Inter-
nal in the Hardware Setup dialog (unless it is ref-
erenced to another clock source or peripheral). 
You should then set your digital effects devices 
to accept an external digital clock so that they 
will synchronize themselves to Pro Tools. Make 
sure you set the channel pair to the digital input 
in the Hardware Setup dialog (or I/O Setup dia-
log).
Chapter 4: Connecting Your Studio 55



56
Connecting MIDI Devices
By adding a Macintosh-compatible MIDI inter-
face to your system, you can take advantage of 
all the MIDI features of Pro Tools, including re-
cording and editing MIDI tracks, and synchro-
nizing to MIDI Time Code or MIDI beat clock.

To connect MIDI devices to your system:

1  Connect the MIDI interface to your computer 
according to the MIDI interface’s documenta-
tion.

2  Install any MIDI driver software required by 
the MIDI interface. (Once you have installed 
your MIDI interface hardware and software, 
confirm that it is working properly using the 
procedure given in the interface’s documenta-
tion.)

3  Connect the MIDI OUT of your MIDI device 
or controller to the MIDI IN of your MIDI inter-
face. 

4  Connect the MIDI IN of your MIDI device or 
controller to the MIDI OUT of your MIDI inter-
face. 

For information on configuring a MIDI con-
trol surface for use with Pro Tools, see the 
electronic PDF version of the Pro Tools 
MIDI Control Surfaces Guide (included 
with Pro Tools).

For Macintosh systems, see Appendix C, 
“Configuring OMS” for information on 
configuring OMS (Open Music System) soft-
ware, which is required for Pro Tools and 
MIDI.
Getting Started with HD
Connecting SMPTE 
Synchronization Devices
If you intend to synchronize Pro Tools to exter-
nal devices with SMPTE using MIDI Time Code, 
your system must be connected properly. For de-
tails on SMPTE and synchronization, see the 
Pro Tools Reference Guide or the SYNC I/O Guide.

Digidesign SYNC I/O

Digidesign’s SYNC I/O is a multi-purpose syn-
chronization peripheral that provides most all 
of the functions and connections needed to 
achieve synchronization to a variety of devices. 

SYNC I/O lets you synchronize Pro Tools to 
LTC, VITC, and Bi-Phase/Tach, or internal for 
positional reference (time code), and supports 
all major clock references.

SYNC I/O offers extremely fast lockup, near-
sample accurate synchronization, and an excep-
tionally low-jitter clock. These features provide 
professional performance and maximum audio 
fidelity under a wide range of synchronization 
conditions.

For more information, refer to the SYNC I/O 
Guide.



chapter 5

Working with Pro Tools
This chapter takes you on a guided tour of 
Pro Tools, introducing its main windows and 
features. Also included is a step-by-step over-
view of basic audio recording (see “Basic Record-
ing” on page 70). 

How to Use This Chapter

If you are new to Pro Tools, read this chapter for 
an overview of how to get started learning to 
record, edit, automate, and mix using 
Pro Tools|HD. 

All of the features described in this chapter are 
explained fully in the Pro Tools Reference Guide. 
Refer to that guide and its index to find addi-
tional information on all Pro Tools features. 
Session Basics
Pro Tools projects are created and saved as ses-
sions. Sessions store all tracks, audio, MIDI, and 
other session information. Audio and fade files 
are stored in folders within the session folder.

Pro Tools remembers audio interface configura-
tion and other system settings and applies them 
to all new sessions. 

Session folder, containing the session file and its Audio 
Files and Fade Files folders
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Starting a Session

The basic steps to set up a new session are:

1  Launch Pro Tools.

2  Choose File > New Session. 

3  In the New Session dialog, set sample rate, bit 
depth, and other options for the new session.

4  Select where you want to save your session. If 
using external hard drives with your Pro Tools 
system, make sure you select the appropriate 
drive in the New Session dialog.

5  Choose Save. The new session opens its Mix, 
Edit, and Transport windows (see Figure 5 on 
page 59).

New Session dialog
Getting Started with HD



Main Windows

The Mix, Edit, and Transport windows are the 
main Pro Tools work areas. You can show any of 
these windows by choosing them from the Win-
dows menu. 

Mix Window Displays the Pro Tools mixer, with 
its familiar fader strip controls for track level, 
pan, solo, mute, and signal routing. 

Edit Window Displays tracks in the session along 
the Timeline, for editing of audio, MIDI, and au-
tomation data. 

Transport Provides standard transport controls 
for Play, Stop, Rewind, Fast-Forward, Pause, and 
Record. The Transport window can also show 
Counter and MIDI Control displays.
Session Setup Provides status display for impor-
tant Pro Tools session settings, including sam-
ple and frame rate, clock source, and file format. 
Also includes the Current Time Code counter, 
and controls for clock reference, positional ref-
erence, and other time code features for the 
Digidesign SYNC I/O. 
S

Figure 5.  Main session windows 
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Session Settings

Pro Tools provides several different Timebase 
Rulers to select the timebase for your session. 
Timebase Rulers, displayed along the top of the 
Edit window, include Bars:Beats, Minutes:Sec-
onds, Time Code, and Feet.Frames. The current 
Timebase determines the format of your main 
counters, and provides the basis for the Edit 
window Grid. 

For post production, select either Time Code or 
Feet.Frames as your session Timebase in the Rul-
ers view.

To select a Timebase Ruler:

■ Click the circle next to the displays at the top 
left side of the Edit window (labeled Bars:Beats, 
Time Code, Sample, and so on).

Tempo

You can set a session tempo using the MIDI 
tempo controls in the expanded Transport win-
dow, or using the Tempo ruler. 

To define your session tempo:

■ Click in the Tempo field in the Transport win-
dow, and type in the desired tempo. 

To tap in a session tempo:

1  Choose Display > Transport Window Shows > 
MIDI Controls. 

2  In the Transport MIDI controls, turn off the 
Conductor to enable Manual Tempo mode. 

3  Use the Space bar to click on the Tap button. 
Getting Started with HD
Click and Metronome

Pro Tools provides its own MIDI Click options. 
This feature can be turned on and off using the 
Metronome icon in the Transport window, and 
is configured from the MIDI Click Options dia-
log. 

To configure and enable the Pro Tools click:

1  Choose MIDI > Click Options.

2  Configure the click parameters as needed for 
your MIDI sound source. 

3  During recording or playback, you can turn 
the Click on or off using the Click switch in the 
Transport window, MIDI Controls display. 

Transport window, displaying Click and Tempo Controls 

Tempo Controls

Metronome



Frame Rate and Other Synchronization Settings

To set session frame rate or other synchronization 
settings:

1  Choose Windows > Show Session Setup. 

2  Set parameters as desired. 

Saving Sessions

As you build a session by adding tracks, chang-
ing session parameters, and so forth, you will 
want to save your work. Pro Tools provides 
three ways to save sessions, with each providing 
a different set of options. 

To save a session:

■ Choose File > Save Session, Save Session As, or 
Save a Session Copy In. 

Save Session Saves the currently open session as 
is, leaving it open to continue working.

If you are using an Ethernet or MIDI control 
surface, or an external synchronization pe-
ripheral, choose Setups > Peripherals, then 
select MIDI Controllers or Ethernet Control-
lers, as appropriate, and enable each device.

Saving sessions is most often performed for 
data security, archiving, and in preparation 
for transferring projects. In addition, session 
files can be saved in order to perform sample 
rate conversion, or even to create session 
templates. Session templates are Pro Tools 
sessions that have tracks, routing, plug-ins, 
or any other parameters predefined. See the 
Pro Tools Reference Guide for more infor-
mation about how to create and use session 
templates.
Save Session As  Creates a duplicate session file 
with the name you choose. It does not create a 
new Audio Files or Fade Files folder. This can be 
useful if you want to experiment with different 
arrangements in the session without affecting 
the original session.

Save a Session Copy In  Only saves the files that 
you are using in the current session. This can be 
useful for creating a final copy of the session 
that does not include audio files or fades you are 
no longer using.

System Resources and Settings 

You can customize many Pro Tools system set-
tings in the Playback Engine dialog to optimize 
system performance. 

Playback Engine Dialog

Lets you adjust DSP allocation, number of voices 
(total voiceable tracks), buffers, and other sys-
tem settings. 

To configure system resources:

■ Choose Setup > Playback Engine. For more in-
formation, see “Configuring the Playback En-
gine” on page 21 (Macintosh) or “Configuring 
the Playback Engine” on page 43 (Windows).

Playback Engine dialog for Pro Tools TDM system
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System Usage Window

Displays information on CPU and DSP perfor-
mance. 

To view system resources and usage:

■ Choose Windows > Show System Usage. 

Audio Hardware Configuration

The Hardware Setup and I/O Setup dialogs let 
you configure your audio hardware and basic in-
ternal signal routing. 

Hardware Setup Dialog

Configures audio interfaces. Includes settings 
for input and output levels, hardware routing, 
and clock source (sync mode). 

Meters in the System Usage window (TDM shown)

Hardware Setup dialog
Getting Started with HD
To configure audio interfaces and other hardware 
peripherals:

■ Choose Setup > Hardware Setup.

For more information, see “Configuring Hard-
ware Setup (Audio Interfaces)” on page 22 for 
Macintosh systems, or “Configuring Hardware 
Setup (Audio Interfaces)” on page 45 for Win-
dows systems.

I/O Setup

Maps Pro Tools channels to hardware inputs 
and outputs. The I/O Setup dialog lets you cus-
tomize the Pro Tools mixer to match your work 
style and the needs of your projects. 

To change your I/O Setup:

■ Choose Setup > I/O Setup.

For more information, see the Pro Tools Reference 
Guide.

I/O Setup dialog



Transport Controls
The Transport window provides all Pro Tools 
transport commands. There are different avail-
able transport controls that can be displayed or 
hidden by selecting or deselecting them in the 
Transport Window Shows sub-menu.

To show the Transport window:

■ Choose Window > Show Transport Window. 

To configure the Transport window:

■ Choose Display > Transport Window Shows 
and select the desired view options. 

In standard view, the Transport window pro-
vides Play, Stop, and other standard transport 
controls. The Expanded Transport window pro-
vides pre- and post-roll, start, end, and length 
indicators for Timeline selection, as well as the 
Transport Master selector. The Transport win-
dow can also display the following MIDI Con-
trols: Wait for Note, Click, Countoff, MIDI 
Merge, Conductor, Meter, and Tempo. 

Transport window

Pro Tools starts playing from the location of 
the cursor, or from the beginning of the cur-
rent selection. The current setting of the 
Link Edit/Timeline command in the Opera-
tions menu also affects playback. See the 
Pro Tools Reference Guide for more infor-
mation.

Online

Rewind

Stop

Play

Record

Return To Zero

Go to End

Fast Forward
Timeline and Navigation
Pro Tools provides many ways to navigate in a 
session, including using the mouse, and enter-
ing a location into one of the counters. 

To navigate to a location in the Edit window:

■ Click at the desired location with the insert 
bar.

To navigate using the counters:

■ Click in the Main counter and enter the de-
sired location using your computer keyboard. 

Navigating in the Edit window

Navigating in the Counter

Press the * key on the numeric keypad as an 
alternative to clicking in the counter. 

Click in a track, or on a Time Scale

Click and enter a location into either counter
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Memory Locations 

Memory locations provide another way to navi-
gate within sessions. 

To define a memory location:

■ Press the Enter key on the numeric keypad 
while stopped or during playback. The New 
Memory Location window appears, in which 
you can define a marker, store a selection, or 
store any combination of the other available set-
tings. These settings include track height, group 
enables, pre- and post-roll values, and track 
Show/Hide. Choose settings for the marker and 
click OK. 

To go to a stored memory location: 

■ Press the Decimal key on the numeric keypad, 
followed by the marker number, followed by the 
Decimal key. 
Getting Started with HD
Viewing and Zooming

When viewing tracks in the Edit window, you 
can adjust the height of tracks as well as zoom in 
vertically and horizontally using the Track 
Height selector and Zoom tools.

To change track height:

■ Click the Track Height Selector, and select a 
view size for the track. 

To Zoom in on any area of a track in the Edit 
window:

1  Click to select the Zoomer.

2  Click or drag with the Zoomer to zoom in hor-
izontally for a track or Ruler. 

Zoom and Track Height tools in the Edit window

You can apply many commands, including 
changing the track height selection, to more 
than just a single track. Hold down the Op-
tion key (Macintosh) or Alt key (Windows) 
while performing the operation to apply it to 
all tracks; or hold down both the Shift and 
Option keys (Macintosh) or Shift and Alt 
keys (Windows) while performing the oper-
ation to apply it to all selected tracks.

Zoom presets

 Zoom buttons

Zoomer

Track Height Selector



To zoom in or out, incrementally:

■ Click the appropriate Zoom button. 

• Left Arrow (Horizontal Zoom Out)

• Right Arrow (Horizontal Zoom In)

• Waveform and MIDI buttons, to increase or 
decrease vertical zoom of the appropriate 
track type (audio, or MIDI)

Pro Tools also provides five Zoom preset but-
tons. You can use these to immediately return to 
established zoom levels (you can define the 
magnification level for each preset, on a session-
by-session basis).

To use a stored Zoom preset:

■ Click the appropriate Zoom preset switch 1–5.

To store a new Zoom preset definition:

■ Command-click a Zoom preset number to 
store the current horizontal and vertical Zoom 
to that preset. 

Using Memory Locations for Zoom Control

Pro Tools Memory Locations let you store many 
attributes with each marker or memory loca-
tion, including Track Height and Zoom Settings. 
By creating Memory Locations that are neither 
Markers or Selections, but have Track Height, 
Zoom Settings, or other options enabled, you 
can use Memory Locations to zoom in and out 
using just the numeric keypad.
Tracks
Pro Tools lets you create audio and MIDI tracks 
as needed, for audio and MIDI recording, sub-
mixing, routing, automating, and editing.

To create a new track:

■ Choose File > New Tracks. 

Pro Tools provides four types of tracks: Audio 
Tracks, Auxiliary Inputs, Master Faders, and 
MIDI Tracks. Audio Tracks, Auxiliary Inputs, 
and Master Faders can be mono, stereo, or any 
of the supported multichannel formats for sur-
round mixing.

Audio Tracks Record and play back audio to and 
from hard disk, monitor audio input when 
record-enabled, and edit audio regions.

Auxiliary Inputs Audio mixer channels, used for 
input, routing, and submixing.

Master Faders Provide master channel controls 
and options for any Output or Bus path.

MIDI Tracks Record, play back, and edit MIDI 
data.

New Track dialog
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Audio, Auxiliary Input, Master Fader, and MIDI 
tracks appear as vertical channel strips in the 
Mix window. Track type is indicated by the 
Track Type icons, just below the faders. 

In the Edit window, tracks are displayed hori-
zontally along the Timeline. The area in which 
audio appears for each track is the Playlist. 

Audio, Auxiliary Input, Master Fader, and MIDI 
tracks can be automated. (See “Mix Automa-
tion” on page 70 for more information.)

Tracks in the Mix window

Timeline Rulers and a stereo Audio track in the Edit 
window 

Audio Aux Master MIDI
FaderInput

Audio Track

Timeline
Rulers View
Getting Started with HD



Figure 6.  Stereo audio track in the Mix window
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Audio Tracks

All audio tracks—whether audio (disk) tracks, 
Auxiliary Inputs, or Master Faders—share many 
identical controls. Figure 6 above shows the 
controls found in an audio or Auxiliary Input 
track. 

Master Fader tracks provide all the same features 
as audio and Auxiliary Input tracks, with the fol-
lowing exceptions: 

Input Selector A Master Fader’s output assign-
ment determines its input, or source.
Sends Master Faders do not provide sends. Use 
Auxiliary Inputs instead, or multi-assign its out-
put.

MIDI Tracks

MIDI tracks provide track level, solo, and mute, 
in addition to MIDI input, output, channel, and 
program (patch) controls. MIDI volume, mute, 
and pan can also be automated using Pro Tools 
automation features (see “Mix Automation” on 
page 70 for more information).
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Editing
Pro Tools provides many tools for editing audio 
and MIDI tracks. Editing is done primarily in the 
Edit window. The Edit window toolbar provides 
Edit mode and Edit Tool selectors. 

Audio and MIDI editing are typically used to:

• Fix or replace mistakes.

• Re-arrange songs and projects.

• Clean up track timing and rhythm by aligning 
hits to Grid values like bars and beats, time 
code, or other timebases. 

• Create final tracks using selections from mul-
tiple takes (also known as a comp track, or 
compilation).

Playlists and Non-Destructive Editing

Playlists let you create and retrieve multiple ver-
sions of track edits. A playlist can be a complete 
take, an overdub, or an arrangement of selec-
tions from multiple takes. You can duplicate 
playlists to save edits in their current state, then 
continue making additional edits to the new 
playlist knowing you can always go back to the 
previous version. 

Edit modes and tools (Grid mode, SmartTool enabled)

Duplicating a playlist

Edit Modes Edit Tools
Getting Started with HD
The Mixer
The Pro Tools mix environment provides many 
familiar channel strip controls for setting track 
level, pan, solo, and mute. Mixer and I/O con-
trols can be shown in both the Mix and Edit 
windows.

Basic Signal Routing

Signal routing is accomplished by assigning 
track inputs and outputs. Audio track inputs can 
be from any hardware input. Once recorded, an 
audio track’s input is its audio file on disk. Aux-
iliary Track inputs can be any hardware input or 
internal mix bus. For all types of audio tracks, 
outputs can be routed to any hardware output 
or internal bus send.

Together, these signal routing features let you 
set up virtually any mixer architecture needed 
for your projects, including submixing, sends 
and returns for effects processing, and multi-
channel mixing for surround.



Example of a Send and Return

Auxiliary Input tracks can be created to act as re-
turn channels for busses, as well as for inputs 
from hardware sources. 

Master Faders

Master Faders are provided, to be used as output 
and bus masters. Master Faders can be used for 
master level, solo, mute, and insert assignment 
(plug-ins or hardware inserts) of any mono, ste-
reo, or multichannel Output or Bus path. 

The available choices for inputs, outputs, and 
busses are configured in the I/O Setup window. 
For more information on the I/O Setup window, 
see the Pro Tools Reference Guide. 

Audio and Auxiliary Input tracks configured for a send 
and return

Send Aux Input
to bus 9–10 input from bus 9–10

Send window
Plug-Ins 
Plug-ins provide EQ, dynamics, delays and 
many other types of effects processing. 

Plug-ins function either in real-time or in non-
real-time. TDM and RTAS plug-ins are non-de-
structive effects, which are inserted on tracks to 
process audio in real-time—just like an external, 
hardware processor (during playback). Audio-
Suite plug-ins, on the other hand, are destruc-
tive effects that process audio files on disk in 
non-real-time.

Real-time plug-ins are assigned to tracks from 
the Inserts view in the Mix or Edit windows. 
Once assigned to a track, plug-ins appear in the 
track’s Inserts view, and can be opened by click-
ing on the Insert button.

Compressor plug-in

Plug-InInsert button
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Pro Tools comes with a complete set of DigiRack 
plug-ins, and many more are available from 
Digidesign and our Development Partners. 

Mix Automation
Mix automation lets you record, or automate, 
changes to track and send levels, mutes, pan, 
and plug-in parameters. MIDI tracks provide 
track level, pan, and mute automation only.

The basic steps for automation recording are:

1  In the Automation Enable window, enable an 
automation type (volume, pan, mute, send level, 
send pan, send mute, or any plug-in automa-
tion).

2  Select an automation mode for the tracks to be 
automated (Write, Touch, Latch, or Trim mode). 

3  Begin playback and begin automation record-
ing, adjusting faders and other controls as de-
sired. Pro Tools remembers all moves performed 
on enabled parameters.

For more information about plug-ins, see 
the DigiRack Plug-Ins Guide, the Digide-
sign Plug-Ins Guide, and the Plug-Ins chap-
ter of the Pro Tools Reference Guide. 

Enabling automation (left) and setting a track 
Automation mode (right)
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Once recorded, automation can be re-recorded, 
or displayed and edited graphically in the Edit 
window. 

Basic Recording
This section describes how to record audio and 
MIDI tracks in Pro Tools. 

Routing Audio to a Track

To route audio to a track:

1  Verify the connections to your instruments. 
Refer to the guide for your audio interface for 
more information about setting up your studio.

2  Create a new track to record on by choosing 
File > New Track. Select 1 Mono Audio Track and 
click Create.

3  In the Mix window, find the track I/O con-
trols. If it is not already visible, select Display > 
Mix Window Shows > I/O View. The I/O View is 
located below the sends and above the solo and 
mute buttons.

4  Click the Input button of the new track. 

Volume automation in a track in the Edit window

Pro Tools also provides Automation Safe 
mode for protecting plug–in automation 
from being overwritten, as well as many Au-
tomation Preferences to fine-tune perfor-
mance. See the Pro Tools Reference Guide.

Track View set to Volume

Volume breakpoint automation



Figure 7.  Routing an input to a mono track

Analog inputs

Optical (ADAT) inputs
From the pop-up menu, select the input you 
want recorded. For example, specify A 1 if your 
audio source is plugged into analog input 1. See 
Figure 7 on page 71. The menu displays the 
names of the inputs defined in Hardware Setup 
(or I/O Setup dialog).

Setting Levels

Adjust the level of the input at the source (in-
strument, mic pre-amp, or mixer) to set 
Pro Tools recording levels. The key to setting 
proper input levels is to get a signal as loud as 
possible without creating digital clipping. Sig-
nals that get close to the top of the meter in 
Pro Tools use more of the full bit range (the 24 
bits that make up each audio sample). The more 
you are able to maximize this bit range, the bet-
ter the sound quality will be—by setting opti-
mum levels, you will get the least possible noise 
and distortion.

Watch out for digital clipping. Clipping oc-
curs when you feed a signal to an audio de-
vice that is louder than the circuitry can ac-
cept. The result is distortion. Digital 
clipping is harsh, and usually not some-
thing you want to hear at all, so watch 
those meters!
Setting your Reference Levels

To configure input levels for the 96 I/O:

1  In Pro Tools, choose Setups > Hardware. 

2  If using multiple audio interfaces, select the 
desired interface in the Peripherals list. 

3  In the Interface area, click the Analog In tab.

4  Set the desired Reference Level for each Input 
Channel.

5  Click OK.

Increasing gain raises the noise floor. Make 
sure that the device you have connected is 
outputting as strong a signal as possible 
without distorting.

Hardware Setup, 96 I/O Analog In settings
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To configure output levels for the 96 I/O or the 
192 I/O:

1  In Pro Tools, choose Setups > Hardware. 

2  If using multiple audio interfaces, select the 
desired interface in the Peripherals list. 

3  In the Interface area, click the Analog Out tab. 

4  Set the desired Reference Level for each Out-
put Channel.

5  Click OK.

Recording an Audio Track

To record an audio track:

1  Record-enable the desired track, assign its in-
put, and set the input levels appropriately.

2  In the Transport window (Windows > Show 
Transport), click Return To Zero to ensure that 
you are starting from the beginning of the ses-
sion. You can also record according to a selec-
tion or from the cursor location in the Edit 
window. 

3  Click Record in the Transport window to en-
able recording.

4  Click Play or press the Spacebar to record on 
all record-enabled tracks.

5  Start playing your instrument.

Hardware Setup, 96 I/O Analog Out settings
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6  Click Stop in the Transport window or press 
the Spacebar when you are done recording.

To play back a recorded track:

1  Disable the track’s Record-enable button.

2  Click Play in the Transport window or press 
the Spacebar to start playback.

3  Click Stop in the Transport window or press 
the Spacebar to stop playback.

Recording To and From Digital 
Devices

Using a single 96 I/O audio interface, you can 
digitally transfer as many as eight tracks at a 
time to or from a digital device (such as an 
ADAT). You can transfer up to 16 tracks on a sin-
gle 192 I/O and up to 96 channels with multiple 
192 I/Os.

Setting Digital Format and Clock Source

Before recording from a digital source, make 
sure you have enabled the appropriate Digital 
Format in Hardware Setup. Digital Format de-
faults to AES/EBU, meaning your HD I/O will lis-
ten to the AES/EBU (Encl) In port for digital 
clock. If you want to record from a DAT ma-
chine connected to your S/PDIF RCA inputs, se-
lect S/PDIF Digi Format. If using multiple HD 
I/Os, be sure to configure the appropriate one in 
Hardware Setup. 

After enabling a different digital format, appro-
priate clock signals will become available in the 
Clock Source selector. If you have multiple in-
terfaces, choose the appropriate clock source, on 
the desired HD I/O.



Using Output Pairs

Because of the way that outputs function in 
Pro Tools, each track looks for a stereo output 
pair. This means that in order to record to eight 
ADAT tracks, you have to send four pairs of 
Pro Tools tracks (each pair panned hard left and 
right) to four pairs of ADAT Optical Digital out-
puts.

Working with 88.2 kHz or Higher Sessions

If the session sample rate is 88.2 kHz or higher, 
ADAT and TDIF sources can still be used with 
Digidesign’s 192 I/O, but the SRC (sample-rate 
converter) chips must be enabled. 96 I/O audio 
interfaces do not have SR Conversion capability, 
and the ADAT port will go offline with sample 
rates above 48 kHz.

When the SR Conversion option is disabled, sig-
nal does not pass through the sample rate con-
verter.

To enable SR Conversion on the 192 I/O:

1  Choose Setups > Hardware in Pro Tools.

2  From the Peripherals list, select the primary 
192 I/O audio interface.

3  Select the Digital tab.

4  Select the desired Input Format (AES/EBU 1–8, 
ADAT 1–8, or TDIF 1–8).
5  Enable SR Conversion for each channel pair as 
desired.

ADAT to Pro Tools

The 192 I/O provides 16 channels of ADAT in-
put and output (eight on the chassis, eight on 
the digital card). These inputs and outputs are 
numbered 9–16 and 17–24 by default in the 
Pro Tools Hardware Setup and I/O Setup dialogs.

The 96 I/O provides eight channels of ADAT in-
put and output. These inputs and outputs are la-
beled Optical 1–8 and ADAT 1–8 by default in 
the Pro Tools Hardware Setup and I/O Setup di-
alogs.

To record ADAT tracks in Pro Tools:

1  Connect the Optical Out connector from your 
ADAT deck to the Optical In connector on the 
back of the 96 I/O or 192 I/O audio interface.

2  Open or create a session in Pro Tools.

3  Create the appropriate number (eight) of new 
tracks (choose File > New Tracks).

4  Assign Pro Tools track inputs. For each track, 
click its Input selector and assign Inputs 9–16 to 
your eight tracks, or however many inputs you 
plan to record. See Figure 8 below.
Figure 8.  Routing an Optical input pair to a stereo track

Analog inputs

Optical (ADAT) inputs
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5  Record-enable up to eight audio tracks (de-
pending on how many tracks are used on the 
ADAT tape).

6  Click Record in the Transport window.

7  Click Play in the Transport window to begin 
recording, then press Play on the ADAT.

8  When playback from the ADAT tape is fin-
ished, click Stop in the Transport window, or 
press the Spacebar.

Pro Tools to ADAT

To record Pro Tools tracks to ADAT:

1  Connect the Optical Out connector on your 
Pro Tools|HD audio interface to the Optical In 
connector on the back of the ADAT deck.

2  Open the session you want to record to ADAT.

3  Record-enable up to eight tracks on the ADAT.

4  On the ADAT, enable Digital In. 

5  In Pro Tools, pan the four pairs of tracks you 
want to record to ADAT so that each pair is 
panned hard stereo (one track of each pair is 
panned all the way left, and the other is panned 
all the way right).

6  Route each track pair to a separate Optical out-
put pair by selecting from the Output pop-up 
menu for each track. 

7  Start recording on the ADAT, then click Play in 
the Pro Tools Transport window. When play-
back is complete, stop both systems. 
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Recording MIDI 

To configure a new MIDI track for recording:

1  Choose File > New Track and specify 1 MIDI 
Track, then click Create.

2  In the Mix window, click on the track’s MIDI 
Device/Channel Selector and assign a device 
and channel from the pop-up menu.

3  If you want, you can assign a default program 
change to the track by clicking on the Program 
button in the Mix window and making the nec-
essary selections for program and bank select, 
and then click Done. Default program changes 
are sent when playing a track.

4  In the Mix Window, record-enable the MIDI 
track.

5  Make sure MIDI > MIDI Thru is selected, then 
play some notes on your MIDI controller. The 
MIDI instrument assigned to the track should 
sound, and the track’s meters should register 
MIDI activity.

To record the new MIDI track:

1  Verify that the MIDI track you want to record 
to is record-enabled and receiving MIDI.

2  In the Transport window, click Return To Zero 
to ensure that recording starts from the begin-
ning of the track. You can also record according 
to a selection or from the cursor location in the 
Edit window. 

MIDI Device Channel Selector



3  Click Record in the Transport window.

4  Click Play in the Transport window or press 
the Spacebar to begin recording.

– or –

If using Wait for Note, the Play, Record, and 
Wait for Note buttons flash. Recording begins 
when the first MIDI event is received.

– or –

If using Countoff, click Play. The Record and 
Play buttons flash during the Countoff—after 
which, recording begins.

5  Play your MIDI instrument.

6  When you have finished recording, click Stop 
in the Transport window, or press the Spacebar. 
The newly recorded MIDI data appears as a MIDI 
region on the track in the Edit window, as well 
as in the MIDI Regions List.

To play back the recorded MIDI track:

1  Disable record-enable on the MIDI track to 
take it out of Record-Ready mode.

2  In the Transport window, click Return To Zero.

3  Click Play in the Transport window to begin 
playback. The recorded MIDI data plays back 
through the track’s assigned instrument and 
channel.

Monitoring MIDI Instruments Without a Mixer

Create an Auxiliary Input to monitor your MIDI 
instrument. Auxiliary Inputs function as inputs 
for both internally bussed signals and external 
audio sources.

To configure an Auxiliary Input for MIDI 
monitoring:

1  Connect the MIDI instrument’s audio output 
to the appropriate inputs on your audio inter-
face.
2  Choose File > New Track and specify 1 mono 
or stereo Auxiliary Input track, then click Cre-
ate.

3  Click the Input selector of the Auxiliary Input 
channel and choose the input to which your 
MIDI instrument is connected. 

4  Click the Output selector of the Auxiliary In-
put channel and choose an output.

5  Adjust the level of the Auxiliary Input with its 
volume fader.
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appendix a

Connecting SCSI Drives
SCSI hard drives function as the recommended 
recording media for Pro Tools TDM systems; it is 
there that Pro Tools sessions and audio files are 
kept.

Although Pro Tools will let you record to your 
system drive, this is generally not recom-
mended. Performance for recording and play-
back on system drives is worse than on non-sys-
tem drives, resulting in lower track counts and 
fewer plug-ins.

SCSI hard drives offer several advantages over 
ATA/IDE drives. First, SCSI drives can be exter-
nal and therefore provide portable audio storage 
that is easily moved between systems. Second, 
SCSI drives offer better performance when re-
cording to large numbers of tracks; attempting 
to record to a large number of audio tracks with 
an ATA/IDE drive results in a short delay before 
recording begins.

SCSI Requirements

High-Performance SCSI Drives and 
SCSI Host Bus Adapters

For 96-track, 24-bit, at 44.1 or 48 kHz perfor-
mance, a TDM system must include at least 
three Digidesign-qualified SCSI hard drives at-
tached to a qualified SCSI HBA (host bus 
adapter) card.
For 96-track sessions that have substantial edit 
densities (such as one edit every third of a sec-
ond across 96 voices) or large amounts of cross-
fades, up to four SCSI drives may be required, al-
located with 24 tracks per drive and two drives 
per SCSI channel.

The following track count and sample rate ex-
amples require four hard drives:

• 128 tracks at 44.1 or 48 kHz

• 64 tracks at 88.2 or 96 kHz

• 24 tracks at 176.4 or 192 kHz

SCSI drives must provide a data transfer rate of 
at least 9 MB per second of sustained through-
put. 

Refer to the Digidesign Web site for compatible 
hard drives and HBA cards:

www.digidesign.com/compato/

Software RAID is not supported for audio 
drives.
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SCSI Cables

Use shorter SCSI cables to improve reliability. 
Table 1 provides guidelines for maximum cable 
lengths according to SCSI type.

In the following table, the maximum cable 
length includes all cables used in the chain, not 
just point-to-point connections.

Table 1: Maximum cable length and number of drives 
supported according to SCSI type

SCSI type and 
transfer rate

maximum 
cable length

maximum # 
of drives

Fast SCSI
10 MB/sec

3 meters 8

Wide SCSI
20 MB/sec

3 meters 16

Ultra SCSI
20 MB/sec
(8-bit narrow)

3 meters 5

Ultra SCSI
40 MB/sec
(16-bit wide)

3 meters 5

Ultra SCSI
20 MB/sec
(8-bit narrow)

1.5 meters 6–8

Ultra SCSI
40 MB/sec
(16-bit wide)

1.5 meters 6–8

Ultra2 SCSI
Low Voltage Dif-
ferential (LVD)
80 MB/sec

1.2 meters 16
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Disk Space for Audio Tracks

A single mono audio track recorded at 24-bit res-
olution at a CD-fidelity sampling rate of 
44.1 kHz requires about 7.5 MB of hard drive 
space per minute. The same track recorded at 
16-bit resolution requires about 5 MB per 
minute. Stereo tracks require about twice as 
much hard drive space.

Using these guidelines:

• 128 mono tracks of 44.1/48 kHz, 24-bit audio 
takes up about 969 MB (44.1kHz) or 1055 MB 
(48kHz) of hard drive space per minute.

• 128 mono tracks of 44.1/48 kHz, 16-bit audio 
takes up about 646 MB (44.1 kHz) or 703 MB 
(48kHz) of hard drive space per minute.

• 64 mono tracks of 88.2 or 96 kHz, 24-bit audio 
takes up about 969 MB (88.2kHz) or 1055 MB 
(96kHz) of hard drive space per minute.

• 64 mono tracks of 88.2 or 96 kHz, 16-bit audio 
takes up about 646 MB (88.2 kHz) or 703 MB 
(96kHz) of hard drive space per minute.

• 24 mono tracks of 176.4 or 192 kHz, 24-bit au-
dio takes up about 727 MB (176.4kHz) or 791 
MB (192kHz) of hard drive space per minute.

A 36-gigabyte drive holds:

• about 35 minutes of 128 tracks, 44.1 or 48 
kHz, 24-bit audio 

• about 52 minutes of 128 tracks, 44.1 or 48 
kHz, 16-bit audio 

• about 35 minutes of 64 tracks, 88.2 or 96 kHz, 
24-bit audio 

• about 46 minutes of 24 tracks, 176.4 or 192 
kHz, 24-bit audio 



Distribute Audio Across Multiple Drives

For best recording and playback performance, 
don’t record and play back all audio files in a 
session from the same drive. Instead, use 
Pro Tools Disk Allocation features to distribute 
audio files between multiple drives. See the 
Pro Tools Reference Guide for details.

Separate Video and Audio Files

If you are working with QuickTime, movie files 
must reside on a different SCSI bus than audio 
files. If audio files reside on disks connected to a 
SCSI HBA card, video data should reside on 
drives connected to a different SCSI bus.

Dual-Channel SCSI HBA Cards

If you use a dual-channel SCSI HBA card, equally 
allocate audio files to drives connected to each 
of the two busses on the card for optimal perfor-
mance.

If using video files, make sure to put your video 
files on one bus and audio files on the other bus.

Connecting SCSI Drives

To connect an external SCSI drive:

1  Turn off power to both the computer and the 
hard drive.

2  Attach a SCSI cable from the SCSI port of the 
hard drive to the SCSI port of the SCSI HBA card 
or computer depending on your system’s SCSI 
requirements.

3  Secure the cable’s connectors to the hard drive 
and computer. Loose cables can cause data loss.

4  Connect additional drives by daisy-chaining 
from one drive to another. Keep cable lengths to 
a minimum (see Table 1).
5  Verify that the last SCSI device connected is 
properly terminated. (See “SCSI Termination” 
on page 80.)

6  Attach power cables to the hard drives.

Connecting a SCSI cable to a SCSI HBA card

Connecting an external SCSI hard drive

to SCSI hard drive

SCSI accelerator card

to SCSI accelerator card
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SCSI Termination

Your computer’s SCSI chain must be properly 
terminated or your system will not function cor-
rectly. Only the last device on the chain should 
be terminated using the termination type rec-
ommended by the hard drive manufacturer. 

The drive should use either an external termina-
tor plug or have its internal terminators en-
abled. If you are using a terminator plug, Digide-
sign recommends that you purchase and use an 
active terminator.

Quick Formatting a SCSI 
Drives

Macintosh Requirements

On Macintosh systems, SCSI hard drives used 
for audio recording on TDM systems must be 
formatted (or initialized) for either the HFS or 
HFS+ file system. Drive partitions of up to 
2 terabytes (2000 gigabytes) can be used.

TDM systems require that you use the Ex-
pressPro-Tools software from ATTO (included 
with Pro Tools) for all drive formatting and par-
titioning; only one disk utility should be used 
for all drives in a system.

Do not enable internal termination and in-
stall an external terminator plug on the 
same drive. This will cause SCSI errors. See 
your hard drive’s documentation for infor-
mation regarding which type of termination 
it uses. 
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Windows Requirements

SCSI hard drives used for audio recording on 
TDM systems must be formatted for the FAT32, 
or NTFS files system. Under Windows 2000 and 
Windows XP, NTFS drive partition sizes are al-
most limitless, whereas FAT32 drive partitions 
have a limit of 32 GB.

TDM Windows systems require that you use Mi-
crosoft Windows Disk Administration software 
for drive formatting and partitioning. Use only 
one disk utility for all drives in a system.

Initializing a Macintosh Drive

To initialize a new drive:

1  Turn on your hard drives, computer, and any 
other peripherals.

2  Use ATTO’s ExpressPro-Tools software version 
2.3.2 to initialize and partition any new hard 
drives.

Pro Tools for Windows 2000 allows you to 
connect Macintosh-formatted hard drives 
and play sessions created on Pro Tools for 
Macintosh when using MacOpener from 
DataViz. An installer for the demo version 
of MacOpener is included as an installation 
option for Pro Tools.

Refer to the ExpressPro-Tools User’s Manual.

If you have existing FWB-formatted drives, 
don’t install the ExpressPro-Tools exten-
sion; this can cause a conflict. This exten-
sion is not required to use the ExpressPro-
Tools software (to format new drives).



Initializing a Windows Drive

To format a new drive:

1  Turn on your hard drives, computer, and any 
other peripherals.

2  Use Microsoft’s Disk Management software, 
located in the Administrative Tools control 
panel under Computer Management > Storage.

Refer to your Windows manual or help for infor-
mation on how to use the Disk Management 
software.

General Hard Drive 
Maintenance Information

Formatting Drives

There are two different types of formatting: 
high-level formatting and low-level formatting.

High-Level Formatting (Initialization)

High-level formatting, or initializing a drive re-
places the drive’s directory, volume partition 
map and drivers. Information about the drive is 
created and drivers that communicate this in-
formation to the host CPU are installed. The 
drive itself is not erased, nor is verification per-
formed.

If using Macintosh drives on Windows sys-
tems, refer to“Using Macintosh Drives on 
Windows Systems” on page 83.

Digidesign does not recommend low-level 
formatting.
When is High-Level Formatting Necessary?

It is generally necessary to high-level format a 
hard drive in one of the following cases:

◆ If a new drive is being prepared for use on a 
computer for the first time and the drive is not 
already high-level formatted. 

◆ If you suspect that the directories containing 
the drive’s information have become corrupted.

◆ If a drive is being changed from one platform 
to another. For example if you are switching 
from a Macintosh to a Windows-based system, 
or from a Windows to a Macintosh-based sys-
tem, the drive must be high-level re-formatted 
for the new operating system.

Low-Level (Physical) Formatting

Low-level formatting means completely erasing 
the hard drive and rewriting each sector address 
on the drive. In low-level formatting, the sector 
and track addresses, error-correction codes, and 
other details are written on the platters of the 
hard drive in the form of a magnetic pattern. A 
low-level format permanently erases all data on 
the drive. 

When is Low-Level Formatting Necessary?

Virtually all hard drives come pre-formatted 
from the manufacturer. Low-level formatting is 
generally unnecessary except in rare circum-
stances. They are:

◆ If you want to change the Block Size of the 
drive. This is not recommended by Digidesign. 
Digidesign systems only recognize 512-byte 
blocks.

◆ If you want to perform permanent deletion of 
data.

◆ If you want to clean a drive that is being mi-
grated from one operating system to another 
(for instance, from UNIX to Macintosh).
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Should you decide low-level formatting is neces-
sary, keep in mind that it can take up to three 
hours or more (depending on the size of the 
drive). Avoid power interruptions and computer 
bus resets during the format operation or per-
manent damage to the drive could occur. In ad-
dition, leave the drive powered on for at least 30 
minutes prior to formatting so that the drive has 
time to make any necessary thermal adjust-
ments or recalibrations.

Partitioning Drives

Partitioning divides a physical drive into multi-
ple, unique volumes, almost as if you were cre-
ating virtual hard drives. Partitioning is usually 
performed when the drive is high-level format-
ted (Macintosh) or initialized (Windows).

Seek Times on Partitioned Drives

Seek times are actually faster on partitioned 
drives (assuming that reads and writes are per-
formed on a single partition), since the heads 
only have to seek within the partition bound-
aries, rather than the whole capacity of the 
drive.

Mac OS 7.6.1 and above allows drives 
larger than 4096 MB to be seen as whole 
volumes. Drives must be initialized with 
ExpressPro-Tools (or another utility) that 
recognizes the 2 terabyte limit. Single files 
cannot exceed 2048 MB in size.

Windows 2000 allows drives formatted 
with the NTFS or FAT32 file systems to be 
seen as whole volumes. Single Pro Tools au-
dio files cannot exceed 2048 MB in size.
Getting Started with HD
In addition, smaller partitions perform faster 
than larger partitions. However, this comes at 
the expense of contiguous storage space. When 
you partition a drive, you will need to find the 
compromise that best suits your performance 
and storage requirements. 

Avoiding File Fragmentation

For maximum recording and playback effi-
ciency, data should be written to your hard 
drive in a contiguous fashion—minimizing the 
seek requirements to play back the data. Unfor-
tunately, your computer can’t always store the 
sound files in this way and must write to disk 
wherever it can find space.

In multitrack recording, audio tracks are written 
in discrete files, spaced evenly across the disk. 
While fragmentation of individual files may be 
zero, the tracks may be far enough apart that 
playback will still be very seek-intensive. Also, 
the remaining free space on the disk will be dis-
contiguous, increasing the likelihood of file 
fragmentation on subsequent record passes.

Increased fragmentation increases the chance of 
disk errors, which can interfere with playback of 
audio, and result in performance errors.

Avoid distributing audio files within a ses-
sion over different partitions on the same 
drive since this will adversely affect drive 
performance.

On Windows, to avoid fragmentation, for-
mat drives with higher cluster sizes (such as 
32K).

On Macintosh, if Norton Utilities is used, it 
must be Norton Utilities v4.0 or later to en-
sure compatibility with HFS+ drives.



Optimizing (Defragmenting) Drives

To prevent fragmentation, you can optimize 
your drive, which rearranges your files into a 
contiguous format. Most optimizing software 
lets you run a check on a drive to find out the 
percentage of fragmentation. If your drive 
shows moderate to heavy fragmentation, you 
should consider optimizing it.

If you use your system for intensive editing, or if 
you frequently delete audio or fade files from 
your hard drive, you may need to optimize your 
drives on a weekly basis, or even every few days, 
since it doesn’t take long for even a large hard 
drive to become fragmented.

Backing Up Data Before Optimizing

Since your files will be rewritten by the optimi-
zation process, always make a backup copy of 
the data on your hard drive before you optimize 
it. You should also use a hard drive utility to 
find and repair any problems before optimizing 
data. If there is any damage to your hard drive's 
directories prior to optimizing, serious data loss 
may result. 
Using Macintosh Drives on 
Windows Systems
Pro Tools for Windows lets you record and play 
back sessions directly from a Macintosh-format-
ted (HFS or HFS+) drive connected to a Windows 
system. This functionality requires that all Mac-
intosh session and audio files be stored on Mac-
intosh-formatted drives.

To mount HFS or HFS+ drives on a Windows sys-
tem, you must use the MacOpener™ software 
utility by DataViz. An installer for the demo ver-
sion of MacOpener is included as an installation 
option for Pro Tools.

Installing the MacOpener Utility

If selected during Pro Tools installation, the Ma-
cOpener installer was placed on your hard drive 
in the following location:

<user selected folder>\Digidesign\Utilities\Ma-
cOpener 2000 Demo

To Install MacOpener:

1  Quit Pro Tools if it is open.

2  Locate the macopener executable (.exe) file in 
the above location and double-click it to launch 
the installer.

3  Follow the on-screen instructions to install 
MacOpener.

4  When installation is complete, restart your 
computer.

For details on sharing sessions between 
Macintosh and Windows systems, see the 
Pro Tools Reference Guide.
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Enabling the MacOpener Driver

When you are finished installing MacOpener, 
the MacOpener driver must be enabled to 
mount HFS and HFS+ drives.

To enable the settings on the MacOpener Driver:

1  Choose Start > Programs > MacOpener 5.0 > 
MacOpener Driver Preferences.

2  Under Driver Settings, select Enable Ma-
cOpener Driver. 

3  Under Extension Mapping, select Do not add 
the PC extension to the Mac file name.

Mounting HFS Drives

If the MacOpener utility is installed and en-
abled, no additional steps are required to mount 
HFS drives. They appear as normal system drives 
after you connect them and restart your com-
puter. 

Formatting and Maintaining HFS 
and HFS+ Drives

Although you can use MacOpener to format HFS 
and HFS+ drives from a Windows machine, it is 
not recommended for use with Pro Tools. We 
recommend that you connect the drives to a 
Macintosh computer (if possible) and use the 
ExpressPro-Tools software from ATTO (included 
on the Mac Pro Tools CD-ROM).
Getting Started with HD
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DigiTest Error Codes
For the latest version of DigiTest, refer to the 
Digidesign Web site:

www.digidesign.com

DigiTest Error Codes

Code Description

Err3 Cards from different Pro Tools 
systems are incorrectly mixed. 
See the configuration chapters.

Err4 Cards marked with this error are 
installed in the wrong order. See 
the configuration chapters.\.

Err5 Too many cards of this type are 
installed in the system. Refer to 
the Digidesign Web site for com-
patibility information: 
www.digidesign.com/compato/

Err6 A card is installed in a reserve 
slot. For example, a Digidesign 
card is installed in the slot 
reserved for the Expansion Chas-
sis Host Interface card. Refer to 
the configuration chapters, as 
well as related installation guides.

Err1220 SCSI Accelerator card is installed 
in the wrong slot. See the configu-
ration chapters for correct loca-
tion of the card.

Err1221 Expansion Chassis Host Interface 
card is installed in the wrong slot. 
See configuration for correct loca-
tion of the card.
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Configuring OMS
OMS stores a description of your MIDI studio in 
Studio Setup documents, which are edited in the 
OMS Setup application. Once OMS is configured, 
your music applications know which MIDI de-
vices you are using by referencing the current 
Studio Setup document.

Configuring a New Studio 
Setup in OMS
(First-Time OMS Users Only)

When launching Pro Tools the first time, the 
OMS software will prompt you to create a new 
studio setup if OMS was not previously config-
ured. OMS can also be reconfigured by launch-
ing the OMS Setup application (from your OMS 
folder).

Before configuring OMS, make sure your MIDI 
interfaces and devices are connected according 
to the manufacturer’s instructions and powered 
on.
To configure a New Studio Setup in OMS:

1  When prompted to configure a New Studio 
Setup, click OK.

2  If using a USB or PCI-based MIDI interface, 
leave both ports unchecked. Click Search.

OMS searches for and displays any detected 
MIDI interfaces, MIDI cards, and OMS drivers. If 
your interface is not detected, click Trouble-
shoot. Once your interface is detected, you are 
prompted to search for MIDI instruments con-
nected to your interface.

Ports for OMS Driver Search
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3  Click OK to search for MIDI devices connected 
to your MIDI interface. To be detected, the de-
vice must be turned on and have both of its 
MIDI ports connected to your MIDI interface.

OMS searches for and displays any detected 
MIDI devices. Some older instruments, as well as 
some newer ones, may not be recognized by the 
OMS auto-detection routines. 

Devices not recognized by OMS appear with a 
red question mark and are named based on the 
interface or port to which they are connected. 
These devices can be defined as necessary within 
the OMS Setup application (see “Defining MIDI 
Devices in OMS” on page 88).

4  Click OK to save your Studio Setup document.

OMS Driver Setup

Undefined OMS device
Getting Started with HD
Defining MIDI Devices in OMS

To define a MIDI device in OMS Setup:

1  Double-click the device’s icon in the Studio 
Setup window.

2  In the MIDI Device Info dialog, select the 
Manufacture and Model for the device from the 
pop-up menus. If the device is not listed, leave 
the Model set to “other” and enter a name for 
the device.

3  Select the receiving channel for the device. If 
receiving multiple channels, select the option 
for “Is Multitimbral.”

4  If you will record from the device in Pro Tools, 
select the option for “Is Controller.” If the de-
vice will be a source or destination for MIDI 
Time Code, Beat Clock, or MMC, select the ap-
propriate option. 

5  Click Ok.

Defining a MIDI device



Disabling Serial DMA in OMS

Pro Tools requires that you deselect the “Use 
Apple Serial DMA Driver When Available” op-
tion in OMS Setup. If you do not disable this op-
tion, problems will occur with MIDI and syn-
chronization functions in Pro Tools. 

To disable Serial DMA in OMS:

1  Double-click the OMS Setup application.

2  Choose Edit > Preferences.

3  Deselect “Use Apple Serial DMA Driver When 
Available” and click OK.

4  Quit OMS Setup.

5  Reboot your computer.

MIDI Machine Control and the IAC Driver

If you are planning to use MIDI Machine Con-
trol (MMC) for Pro Tools synchronization with 
other MMC-capable devices or applications, you 
must rename the OMS IAC Driver and remove 
the infinity symbol (“∞”) from its name. If you 
do not do this, MMC will not function properly.

To edit the IAC driver’s name:

1  Double-click the OMS Setup application.

2  In the Studio Setup window, double-click the 
IAC driver.

Studio Setup window with IAC Driver
3  Rename “∞ IAC bus #1” to “MMC” and click 
OK.

4  Save your changes.

5  Quit OMS Setup.

Renaming the IAC Driver
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